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Abstract 

 

For certain geotechnical structures, such as dikes and levees, the design quality is heavily reliant on the 

sampling quality. In addition, the extent of consequences on geotechnical design of using parameters 

from samples with a certain degree of disturbance in laboratory tests is unclear. While the available 

literature has been mainly focussed on disturbance experienced by clay samples, the same empirical 

findings are not always applicable to organic soils such as peat and organic clay. The global objective 

of this thesis was to gain an understanding of sampling disturbance in organic soils using both 

established and non-destructive experimental methods. In order to achieve this, the traditional Dutch 

Ackerman sampling technique was compared to that of a recently developed sampler, the Deltares 

Large Diameter Sampler (DLDS). Non-destructive methods and 1D consolidation parameters were 

used to quantify disturbance in organic soil samples. 

 

The results from existing databases showed that organic clay has a clear linear trend between w and RR 

and peat showed no definitive correlation, although the peat sampled by the DLDS had significantly 

higher water contents than the peats from the Ackerman sampler. Moreover, 37% of organic clay and 

peat Ackerman samples had an ∆e/e0 below 7%. Meanwhile, all the DLDS results from the Deltares 

laboratory had an ∆e/e0 of less than 4%. The use of this parameter is still questionable for peats, as the 

higher e0 found in DLDS peats is the cause for low disturbance measurements. However, the ∆e/e0 

index may be used in conjunction with other destructive and non-destructive disturbance parameters. 

Furthermore, the trend showed it becomes increasingly difficult to produce high quality samples with 

increasing in-situ vertical stress.  

 

Using differences in shear wave velocity as a non-destructive disturbance determination technique, it 

was concluded that the increased shear wave velocity in Ackerman samples relative to the DLDS 

samples, although slight, was due to densification of the outermost volume of the sample being 

compressed by the sampling procedure. This effect was further observed in the other non-destructive 

method use in this investigation, CT scanning. Analysis of micro-CT scans showed that all specimens 

had higher greyvalue intensities at the perimeter than at the centre of the sample, however the observed 

effect was 7.4 times higher with the Ackerman specimens than with the DLDS specimens. 

 

The main recommendation is to continue research on the effectiveness of using non-destructive methods 

to quantify sample disturbance in peats. For the sampling industry, it is advised to increase the diameter 

of the Ackerman sampling tubes to between 70 and 120 mm when sampling in peat. In addition, in light 

of the lesser disturbance caused by the DLDS, it is advised to deploy it in shallow peats instead of the 

Ackerman sampler with the current inner diameter of 67 mm. Furthermore, it is recommended to deploy 

both types of samplers side-by-side in sampling projects in order to diminish the effect of site-specific 

variables.  
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1 Introduction  
 

1.1 Problem and research motivation 
 

In the Netherlands, high safety standards must be met for water retaining structures such as dikes and 

levees, due to the catastrophic consequences that flooding imposes to the nation. As a result of the 

required safety standards, highly accurate stability analyses are necessary. In order to satisfy this, soil 

properties and geotechnical parameters used in stability analyses must be established from undisturbed 

geotechnical samples to represent in-situ conditions.  Sample disturbance is defined as the damage to 

structure between particles in a sampled soil. Structural features include cementation, sedimentation, 

etc. The more disturbed a sample becomes, the less representative the derived parameters, from 

laboratory tests, are for in-situ conditions. Different sampling apparatus and methods induce different 

types and levels of disturbance. De-structuration and densification are examples of types of disturbance 

in soils. In general, the larger the sampler, the higher the volume of undisturbed material which may be 

retrieved. Friction occurs along the wall of samplers, which displaces soil along the surface. Therefore, 

the quality of the sample may not be the same throughout the sample.  

 

Currently, it is challenging to explain to engineers and technicians why different sampling techniques 

must be used for different types of soil. Literature suggests that internationally used techniques such as 

piston and tube samplers have a higher degree of disturbance than newer methods used in Norway and 

the UK such as the Sherbrooke block sampler. However, the impact of the degree of disturbance on 

parameters is unknown. Consequently, sample disturbance has an influence on geotechnical design, but 

due to strict safety standards of water retaining structures, the impact is increased with respect to 

assessment of safety against flooding. Therefore, the problem statement is: in practice, lower quality 

samples, with some disturbance, are sometimes accepted for laboratory testing but the consequence on 

parameter accuracy is not fully known. National sampling guidelines of the Netherlands mention the 

use of different sampling techniques depending on the soil and required parameters, however, the large 

majority of sample are still being taken by the Ackerman sampler. These parameters are collected by 

independent waterboards in the Netherlands by the use of the Stichting Toegepast Onderzoek 

Waterbeheer (STOWA) databases. Therefore, more attention needs to be bought to using the most high 

quality method depending on the soil type and geotechnical parameters of interest, instead of innovating 

for high-speed methods. Subsequently, the consequences of using low quality samples for derivation of 

geotechnical parameters will be better established and accounted for. 

 

It is of importance to distinguish the difference between samples and specimens; a sample is the entirety 

of the material extracted in the field within a recorded interval and stored within a container, while a 

specimen is the section of material withdrawn from a sample, prepared for a laboratory test. Presently, 

the most common type of sampling in the Netherlands is tube sampling with the Ackerman sampler, 

for any soil type. As an alternative for sampling in peats, the Deltares Large Diameter Sampler (DLDS) 

was developed by Deltares. This block sampler has considerably larger dimensions and the resulting 

samples are likewise increased in size compared to the Ackerman sampler. The DLDS was developed 

for shallow peats, however, as with the Ackerman sampler, it is possible to reach deeper soils with pre-

drilling of the boring.  

 

In order to validate the utility of using the DLDS and to ensure it meets the high standards for sampling 

peats, consolidation parameters resulting from oedometer testing will be compared to results from 
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traditional sampling methods and to a benchmarking method. The restriction of limiting the study to 

consolidation parameters derived from the incremental loading (IL) oedometer test is due to the 

importance of primary and secondary consolidation of peat, as it is abundant in the Netherlands, 

including in vital flood prevention structures such as dikes. Additionally, the aforementioned 

consolidation parameters are measured with relative ease in the Netherlands. Figure 1 shows evidence 

of the importance of correct sampling methodology due to the clear divergence in peak shear strength 

of heavily and low or non-disturbed samples.  

  

 
Figure 1. Triaxial test results on clay samples with different disturbance levels (ELE has more disturbance relative to JPN) 

showing the effect on the undrained stress-strain response (top) and the effective stress paths (bottom) (Mayne et al., 2009). 

 

Samples of higher quality may not offer additional benefit, or samples of higher quality may only be 

necessary for certain soil types, geotechnical analyses or level of design. This is indicated in Figure 1, 

whereby the peak undrained shear strength differs up to 29% depending on the sampling technique 

used. The study is restricted to peat and organic clay, because these soils have been subject to lesser 

research regarding sampling disturbance. Additionally, organic clays have been included in this study 

as a basis of comparison because the behaviour of its plastic clay counterpart is well established.  

 

 

1.2 Objectives 
 

Main research question: 

How does sampling affect soil properties and the consequent geotechnical design parameters? 

 

Sub-question 1: 

How does the DLDS affect consolidation parameters derived from (IL oedometer) laboratory tests in 

peats, when compared to traditional sampling techniques? 
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Sub-question 2: 

What is the relationship between sample disturbance and classification parameters (yield stress, 

density)? 

 

Sub-question 3:  

How do the properties (density and shear wave velocity) of organic clay and peat samples derived from 

CT scans and bender element testing* compare when different samplers are used? 

 

Thesis objectives: 

• Investigate the influence of the DLDS sampler on sample disturbance of peats. 

• To gain an understanding to what extent consolidation parameters are affected by different 

sampling techniques.  

• Establish possible differences in disturbance levels of samples from different samplers with CT 

scanning and bender element testing. 

*serving as non-destructive disturbance assessment methods for comparison between different 

samplers. 

 

 

1.3 Approach to answering research questions 
 

Sub-question 1 will be partially answered by evidence gathered from the literature study. For the rest 

of the answer, data gathered from the Deltares DLDS database and IL oedometer tests performed at TU 

Delft on soil sampled by the DLDS will be compared to the database of STOWA which entails 

traditional techniques such as Ackerman sampling. Data gathered from the IL oedometer tests carried 

out for this study, and other (destructive) tests from which the results can be used to quantify sample 

disturbance, will form part of the Sample Disturbance Tests (SDT) database. 

 

Sub-question 2 will be answered by IL oedometer tests performed at TU Delft and the available Deltares 

DLDS and STOWA databases. Regression analyses will be performed to determine the effect of 

disturbance on the geotechnical parameters from oedometer results.  

 

In order to answer sub-question 3, computerized tomography (CT) scans will be used to make density 

distributions of samples sampled by the DLDS and Ackerman sampler. This enables distinction 

between different types of features of peat, namely branches, leaves, grass, etc. and account for the 

fibrousity of peat, which is a phenomenon that leads to higher sample disturbance compared to non-

fibrous peat. The resolution of the medical-CT scanner is insufficient to distinguish discrete pores, 

causing an image with large amounts of interference. Therefore, the micro-CT scanner will be used in 

addition to the medical-CT scanner, to capture the densification disturbance type. The bender element 

testing will capture differences in shear wave velocity between sampled and in-situ soil as a measure 

of quality. Bender element testing and CT scanning have the benefit of enabling their use as alternative 

and non-destructive methods for quantifying sample disturbance.  

 

The main research question will be answered after all sub-questions have been answered. By this point, 

a detailed understanding of sample disturbance will have been achieved whereby the changes in 

properties and design parameters resulting from disturbance will be explained. The interaction between 
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parameters (and therefore the antecedent research questions) can be seen in Figure 2, grouped by type 

of laboratory test, showing the link between each area of investigation. 

 

 

 
Figure 2. Constitutive framework of investigated parameters. 
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2 Background information 
 

This section provides an overview of different types of samplers used to obtain soft soil samples. The 

focus lies on samplers used in Western Europe. Different categories for samplers exist depending on 

the sampling mechanism. The categories are block samplers, tube samplers and piston samplers. The 

necessity for different samplers exists due to strict standards in certain countries, such as the NEN-EN-

ISO 22475-1:2021 (NNI, 2021). Additional sampler requirements are necessary in different soil types 

and soil conditions. 

 

2.1 Block samplers 
 

2.1.1 Sherbrooke block sampler 
 

The Sherbrooke block sampler allows the carving of a cylindrical block with a diameter of 250 mm and 

height of 350 mm after pre-augering has taken place. Block sampling is ideal for sensitive, low plasticity 

clays which are heavily influenced by sampling disturbance (Lunne, 1997). Currently, it is widely 

perceived as the most effective method at retrieving an undisturbed sample. Nonetheless, for peats and 

soft organic clays bulging might occur, due to lack of lateral support during and after sampling. It has 

three cutting knives, which are fed with water from ground level in order to circulate the cuttings to the 

surface. A drill rod connected to the sampler allows for rotation while cutting (shown in Figure 3). With 

the use of a horizontal diaphragm installed in the Sherbrooke block sampler, the  bottom of the carved 

block is removed from the in-situ soil (Lunne, 1997).  

 

 
Figure 3. (a) Sherbrooke block sampler (b) schematic view of a block sample being carved (Amundsen et al, 2016). 

 

2.1.2 Deltares Large Diameter Sampler 
 

The Deltares Large Diameter Sampler was especially developed for use in soft soils with high organic 

matter content. Larger samplers often require additional measures to ensure minimal disturbance to the 

sample. In order to prevent bulging after sampling, the sample should have sufficient lateral support 

from the steel tube wall and it is sampled directly into its container as the sample is extracted from its 

in-situ position. Therefore, the Deltares Large Diameter Sampler (DLDS) was designed and developed 
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to be a tube sampler (Zwanenburg, 2017a). The down-hole sampler uses a casing to prevent collapse of 

the borehole after boring. The tube sampler consists of a cutting shoe, knives, the sample tube, a 

protection tube, a top cap and a plunger, configured as shown in Figure 4. The thickest section of the 

cutting shoe is 5 cm with a cutting edge of 10°. Before lifting the sample from the borehole, the knives 

provide a clean horizontal cut once the desired height of the sample has been reached. The sample tube 

is made of stainless steel with a diameter of 0.4 m, thickness of 3 mm and a variable height of 0.5 m or 

1 m. A top cap allows for control of the knives, a connection to the plunger and a valve to let air and/or 

water escape when the sampler is pushed down. The valve is closed when extracting the sample in order 

to cause suction and prevent the sample from sliding down. Finally, the plunger uses six struts to 

securely fix the sampler during sampling (Zwanenburg, 2017a). 

 

 
Figure 4. Components of the DLDS (Zwanenburg, 2017a). 

 

Depending on the laboratory test to be performed, a different amount of block sampler can be prepared 

from a single tube. In the case of oedometer testing, from the total DLDS tube height variant of one 

metre, up to 16 block samples can be prepared. As the samples needed for triaxial testing are larger than 

oedometer samples, fewer samples can be prepared for this testing method. After the removal of 10 cm 

from the top of the tube, a cut is made every 20 cm, as shown in Figure 5, which is further divided into 

quarters as seen from a top view, making four equal blocks in the same dimensions. The bottom 10 cm 

is likewise discarded. These were then wrapped in a layer of plastic foil, followed by a layer of 

aluminium foil. The block samples are sufficiently protected from environmental effects in this 

configuration due to no loss of water to evaporation. The water content (w), which is a ratio of the 

weight of water to the weight of the solids in soil, does not diminish for these blocks, therefore the pore 

pressure remains constant, which results in a constant isotropic effective stress. As these stresses remain 

unchanged during storage, the volume remains constant which reduces susceptibility to disturbance. 
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Figure 5. DLDS sample extraction from tube. The sample is provided with lateral and vertical support during storage (left), 

accurately cut during block preparation (middle) and secured by a crane during transport (middle). 

 

2.1.3 Classical block sampling 
 

The classical block sampling method entails the excavation of a circular trench around the intended 

sample volume. Then, it is trimmed of excess soil and wrapped in cheesecloth. Subsequently, it is 

covering with a thin layer of wax in order to retain the sample shape. This is followed by a wooden or 

metallic box being placed over the intended sample, as shown in Figure 6 (c). Lastly, using a wire, 

shovel, knife or saw (depending on the soil type), the base of the sample is detached from the 

surrounding soil. This sampling method is highly restricted by sampling depth, as it is not only 

economically unfeasible due to the increasingly large pit that needs to be excavated, but also due to the 

impractical matter of dewatering and intensive manual labour involved, as seen in the standard ASTM 

D7015/D7015M (ASTM, 2018).  

 
Figure 6. Classical (rectangular) block sampling method ASTM D7015/D7015M (ASTM, 2018). 
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2.2 Tube samplers 
 

2.2.1 Ackerman sampler 
 

The Ackerman sampler is the most commonly used sampler in the Netherlands. It is a thin-walled 

sampler producing a sample of at least 67 mm in diameter and 300 mm in length. This sampler is less 

suitable for sandy soils due to the need for core catchers, which cause the sample tube to remain fully 

or partially filled, simultaneously causing disturbance (TAW, 2001). In Dutch practice, the tube is 

hammered into the soil to obtain the sample and a recent study (Zwanenburg 2017b) concluded that 

using the static push method has no significant improvement on the results. Figure 7 shows a diagram 

of the sampler and its components. In this figure, the “stalen kogel” (translates to “steel ball” in English), 

is a device which allows for suction at the top of the sampler which results in reduced disturbance.  

 

 

 

 
Figure 7. Ackerman sampler (sizes shown in mm) (TAW, 2001). 

 

2.2.2 Laval sampler 
 

The Laval sampler has a cutting edge of 5°, no inside clearance, 200 mm inner diameter, 218 mm outer 

diameter and (unlike other samplers) can be effectively operated in sandy soil under the water table. 

The sampler head has a central hole which allows for mud expulsion laterally from the sampling tube 

(Wride et al, 2000). Figure 8 (b) shows the operational procedure of the Laval sampler.  
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Figure 8. (a) Schematic of laval sampler (Konrad et al. 1995 and La Rochelle et al. 1981) and (b) cross-section of 

operational procedure (Konrad et al. 1995). 

 

2.2.3 Holle Avegaar (hollow stem auger) sampler 
 

The holle avegaar uses a pilot bit connected to a hollow tube with threads (auger) in order to drill into 

soil (shown in Figure 9). The diameter ranges between 60 and 100 mm, while a length of up to 6 m is 

possible. Once the sampling depth has been reached, the auger tube is held in place while the pilot bit 

is extracted and the sampling tube is inserted. Depending on the diameter of the auger tube, a sampling 

tube is inserted to extract the desired soil sample. The holle avegaar can be operated both over and 

under the water table, however in the latter condition the auger is to be filled with water before 

extracting the pilot bit (Nordmeyer, n.d.). 

 

 
Figure 9. Holle avegaar diagram (Nordmeyer, n.d.). 
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2.3 Piston sampler 
 

The piston sampler is a tube-like sampler, however it uses a piston to actively create suction at the 

interface between the piston and top of the sample, as shown in Figure 10. This means that piston 

samplers can only be used in soils which are below the water table. The piston remains static as the 

outer tube is pushed into the soil. Newer piston samplers may include a vacuum breaker, which reduces 

suction between the sample and piston during disassembly. Piston samplers exist in different diameters, 

for example the Norwegian Geotechnical Institute (NGI) 54 mm and NGI 95 mm (Lunne, 1997).  

 

 
Figure 10. Piston sampler diagram (Chung, 2013). 
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3 Literature study 
 

In this chapter, the available literature on sample disturbance is presented. First, the causes of sample 

disturbance are described. This section is followed by studies conducted on the influence of sample 

disturbance on soil properties and parameters. Thereafter, the current standards and guidelines are 

presented. Finally, the indices and methods used to quantify the level of disturbance described.  

 

 

3.1 Causes of sample disturbance 
 

Sample disturbance is caused by de-cementation of soil particles from external interference of in-situ 

soil leading to either volume reduction or increase. Long term/inappropriate storage can lead to 

disturbance due to loss of suction in the sampling tube, escape of humidity and therefore ultimately 

causing disturbance as the soil compacts. Soils with organic matter have degradation via aerobic and 

anaerobic degradation, which may cause chemical changes in the soil. Factors causing sampling 

disturbance are grouped into several categories such as the geometry of the sampling apparatus, volume 

displacement of the sample and the soil type being sampled. The inside clearance ratio (Ci or ICR), 

which is defined as the difference between the inside diameter of the sampling tube and the inside 

diameter of the cutting edge (Baligh et al., 1987) has the equation shown below (equation 1). This is 

shown in the schematic of Figure 11. In the case that Ci > 0, the soil experiences swelling in the cutting 

shoe at the centre-line of the sampler.  

 

      𝐶𝑖 =
𝐷3−𝐷1

𝐷1
      (1) 

 

 
Figure 11. Sample tube dimensions (DeGroot et al, 2005). 

 

The ratio of the sample height over tube height is called the recovery ratio (in Dutch: “steekverlies”, 

however this is the inverse of the recovery ratio) and is of crucial significance in determining 

disturbance. This is due to the fact that the unfilled volume in the tube allows for the sample to lose its 

structure during transport and storage. Inversely, if the thrust distance is equal to the tube length, but 

only a fraction of soil length is present in the tube, the soil has been compressed by the equivalent empty 
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length of the tube. Commonly, Ackerman samples have a low recovery ratio, averaging 72% for when 

the Ackerman sampler is statically pushing into soil and 65% when the Ackerman sampler is hammered 

into soil (Zwanenburg, 2017b). This means that, often the top of the sampling tube does not contain the 

sampled soil. Ideally, the recovery ratio is close to 100%, in order to avoid movement of the sample 

material within the tube. Instead, this would-be void is mitigated by filling the remaining volume with 

a watertight bag containing sand. This practice could cause compaction of the sample, and therefore 

disturbance due to the added vertical stress (σv). For both the Sherbrooke and DLDS the sampling loss 

is negligible (Zwanenburg, 2017a). 

 

Figure 12 is a sketch of a representative stress path of clay samples during sampling and specimen 

preparation proposed by Ladd and DeGroot (2003). A similar stress path is expected with regard to 

peat. Path 1-2 forms a significant cause of sample disturbance induced by reduction of σv (Ladd and 

DeGroot, 2003). In path 2-3, the increase in deviatoric stress (q) is attributed to a geometric factor of 

the sampler, the Ci, being greater than zero. 

 

 
Figure 12. Centre-line stress path representation during sampling and specimen preparation of clay in tube samples (Ladd 

and DeGroot, 2003). 

 

Swelling and compression during sampling, which is in the category of volume displacement, is 

represented by paths 3-4 and 4-5 respectively (Ladd and DeGroot, 2003). After the soil has passed the 

cutting shoe it enters the tube. In the case that the Ci > 0, the entering soil swells due to the newly 

available volume and lack of confining pressure. Due to the tendency of swelling for soils which 

experience reductions in confining pressure, a complication arises whereby some samples might get 

stuck in a tube with a Ci = 0. Disturbance might then occur when pushing out the sample back out when 

needed.  

 

Path 5-6 is subject to suction during extraction of the tube (Ladd and DeGroot, 2003). The sudden 

change in stress as the soil under the cutting edge tries to resist the extraction of the sample can result 

in disturbance of said sample. Finally, path 6-9 represent the least sample disturbance potential, i.e. 

transportation, storage, handling and preparation of the sample (Ladd and DeGroot, 2003). A study by 

Tanaka (1996) confirmed that transportation and storage represent a very minimal portion of total 

disturbance. The study included clay transported from Drammen, Norway, for unconfined compression 

tests, to two very distant locations: the Norwegian Geotechnical Institute (NGI) and Port and Harbour 
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Research Institute (PHRI), in Japan. The same personnel and test procedures were used in both locations 

and it was found that no systematic difference was present in the results (Tanaka, 1996).  

 

The area ratio (AR) is exclusively used for the cutting shoe, whereby it is defined as the difference 

between the square of the outer and square of the inner diameters, expressed as a ratio by division of 

the inner shoe diameter, as shown in Figure 13. Furthermore, the outside cutting edge angle (OCA) and 

inside cutting edge angle (ICA) are additional parameters used to classify tube samplers. The finite-

element method (FEM) has been used to quantify disturbance from the centreline of the sampler and 

assess the influence of tube sampling via assessment of the influence AR, cutting edge angles and ICR 

(Clayton et al., 1998). FEM results were used as a comparison to analytical computations. The study 

concluded that an increase in the thickness of the sampler wall and therefore an increase in the area 

ratio of the sampler, caused a significant increase in the peak compressive strain during sampling. This 

can be seen in Figure 14, where an increasing AR increases the degree of axial strain in both 

compression and extension zones of the simulated soil. Additionally, it was concluded that an increase 

in the Ci caused an increase in peak strain in extension, similarly described as a cause of disturbance by 

Ladd and DeGroot (2003) and the increasing of the cutting edge angle marked an increase in peak 

compressive strain during sampling (Clayton et al., 1998). 

 

 
Figure 13. Definition of geometric parameters of tube samplers (Ferreira et al., 2011). 

 

 
Figure 14. Centre-line strain paths for tube samplers with different area ratios (AR) (Clayton et al., 1998). 
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Helenelund et al. (1972) used thin-walled sampling tubes, with varying types of cutting edges to sample 

peats. In the paper, it was concluded that considerable compression of fibrous peats takes place 

regardless of the type of cutting edge. Therefore, the (pre-compressed) peat samples have adopted 

different properties than in in-situ conditions (Helenelund et al., 1972). Logically, this suggests that, in 

relation to sample disturbance, distinctions are required, regarding the type of peat. As observed by 

Helenelund et al. in 1972, peats with low fibrousity experience lower pre-compression by the cutting 

edge, while the opposite is true for peats with high fibrousity. The authors of the aforementioned paper 

recommend the use of a sawtooth shape cutting edge when sampling peats and rotary motion to increase 

the chance of cutting cleanly through peat fibres. 

 

 

3.2 Influence of sample disturbance on soil properties and parameters 
 

A newly developed block sampler, the DLDS, showed improvements compared to the Sherbrooke block 

sampler. Zwanenburg (2017a) stated that, from a study on using the DLDS to sample peat and organic 

clays, water content was higher when compared to the Sherbrooke block sampler. In addition, it was 

reported that the ratio between the compression ratio (CR) to recompression ratio (RR) was higher as 

well. The CR is used to quantify the compressibility of the soil, while the recompression ratio is a 

parameter calculated during a reloading stage of the 1D consolidation test, proceeding the lowering of 

a load. Lower density and lower normally consolidated  stiffness were observed compared to the 

Sherbrooke block sampler. No clear difference could be observed in pre-consolidation stress. It is 

important to note that the size of the dataset was insufficient to draw final conclusions. While it is 

unclear how disturbance distributes within samples, only the outermost ‘skin’ of the sample might be 

affected. Therefore, increasing the diameter of a sampler ensures a greater undisturbed volume of the 

sample. This is an additional benefit of the DLDS, which has a diameter of 400 mm compared to the 

250 mm in diameter of the Sherbrooke block sampler. A complication arises when measuring 

disturbance in peats, as a small change in void ratio (e) does not necessarily imply little disturbance due 

to the high compressibility of peat (Zwanenburg, 2017a). 

 

Amundsen et al. (2015) conducted CRS oedometer tests on clay using block sampling and tube 

sampling of different diameters (75 mm and 54 mm). The results displayed in Figure 15, clearly show 

differing σv’ paths depending on depth and sampler used. Furthermore, the constrained modulus 

likewise showed differences between depth and sampler used, notably peaking at differing σv’. The 

constrained modulus depends on the deviator and mean effective stress, therefore horizontal and vertical 

stresses were largely different for each sample type.  
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Figure 15. Oedometer tests on block and tube samples from Klett, Norway (Amundsen et al., 2015). 

 

From Figure 15, it can be identified that the strain response for tube samples (middle and right graph) 

showed a stiffer response compared to the block sample (right). This is especially the case for the 54 

mm sampler results (right), since a significantly higher σv’ is needed to achieve the same axial strain, 

for samples from the same depth. This indicates that the tube samples have been subjected to 

compaction during sampling, hence a higher degree of disturbance compared to the block sample 

results.  

 

The influence of sample disturbance on compressibility properties on peat were investigated in a paper 

by Helenelund et al. (1972). It was noted that the thin walled tube samples showed a stiffer response 

than the block samples due to the densification they had undergone during sampling. The paper 

concluded that using conventional thin walled tubes resulted in 2.5 times higher peak strength compared 

to block sampling. This is in contrast to the finding for clays by Mayne et al (2009), which showed the 

clear divergence in peak shear strength of samples with varying degrees of disturbance. This further 

alures to the importance of sampler selection depending on the soil being sampled. Figure 16 shows 

CRS testing done on clay samples by Lunne et al. (1997) graphed on a logarithmic scale for effective 

axial stress, whereas Amundsen et al. (2015) used a linear scale as seen in Figure 15. 
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Figure 16. CRS tests on Lierstranda clay (Lunne et al., 1997). 

 

Boylan (2008) conducted CRS oedometer tests in the Netherlands on sampled peat via Sherbrooke 

block sampling, piston and hollow auger sampling. He noted that piston and hollow auger sampling 

showed a higher initial stiffness than the block sample. Both the disturbance index (∆e/e0) and modulus 

number were used as sample quality criteria. The former showed that piston and hollow auger samples 

appear of higher quality than the block samples, which is attributed to the high overconsolidation ratio 

(OCR), much higher than the limit of 4 of this criteria, of these samples and the densification effects. 

In contrast, using the modulus number, it was concluded that since the piston and hollow auger samples 

have a higher modulus number, they are less compressible than the block samples. In addition, it was 

concluded that, similar to Zwanenburg (2017a), the disturbance index based on the normalized ∆e is 

misleading for peats, when densification has occurred. In the case that the DLDS does not lead to 

densification of the sampled soil, and the peat is of appropriate OCR, the ∆e/e0 may be used to assess 

the sample quality. Finally, the study by Boylan (2008) indicates that peat samples with high w 

(>500%), will lead to water migration in the sample during storage, resulting in an increased w at the 

bottom and a decreased w at the top of the sample. 

 

 

3.3 Standards and guidelines 
 

Certain samplers can only achieve limited sample quality as detailed in the ISO standard ISO-22475 

(NNI, 2018). This classification is found in Table 1. High sample quality is necessary, i.e. Class 1 

samples, for tests which rely on quantification of strength and structural features of soil, such as triaxial 

and oedometer testing. Only corresponding sampling methods which fall under Category A may be 

used to obtain these samples. With the categorization as presented in Table 1, it demonstrates that, for 

example, it would be poor engineering practice to use methods from sampling category E to aim to 

obtain particle size from samples.  
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Table 1: Quality classes of soil samplers for laboratory testing and sampling categories (NNI, 2021). 

 
 

The ISO standard, ISO-22475 (NNI, 2018) describes Class 1 samples to be suitable for oedometer 

testing. Class 1 samples can only be achieved through category A sampling methods. Samples from 

Class 2 to Class 5 are suitable only for tests where de-structuration of the sample less important. This 

leaves a restricted number of sampling methods that may be used for oedometer tests. As seen in article 

6.3.1.4 of the standard, rotary drilling is the only method by which boreholes should be made to sample 

peat. For organic clays, there are additional methods which can deliver Class 1 samples such as hammer 

driving and rotary hammer driving. Table 2 shows the samplers which must be used to sample certain 

soil types to achieve varying sample qualities. As shown, thin-walled tube samplers of 70 to 120 mm 

diameter, and in rare cases thick-walled tube samplers of 50 to 100 mm diameter, are appropriate for 

sampling organic clays and peats for category A samples. However, the 67 mm inner diameter of the 

thin-walled Ackerman sampler falls just short of this requirement, therefore categorizing into line 3 of 

Table 2, with the appropriate length variants. 
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Table 2: Sampling criteria for tube and block samplers (NNI, 2018). 

 
 

The ASTM standard for the ‘Selection of Soil and Rock Sampling Devices Used With Drill Rigs for 

Environmental Investigations’, ASTM D6169 (2005) gives guidelines for appropriate sampling practice 

of soils. Table 3 shows criteria for suitability of material sampled grouped by different types of 

samplers. Both the ISO-22475 (2018) and ASTM D6169 (2005) standards acknowledge the same 

sample qualities are achieved by sampler type, however differences in nomenclature feature between 

the two. For example, according to the ISO standard (NNI, 2018), a thin-walled sampler will achieve a 

category A sample (highest possible category) for fine and soft or stiff soils and the ASTM standard 

describes fine grained soft or stiff soil samples from a thin-walled sampler as E (Excellent, highest 

possible category).  

 

 

Table 3: Suitability of core sampling devices for different geologic materials (ASTM D6169) 

 
Ratings: E = excellent; G = good; F = fair; P = poor; NA = not applicable.  

 

D Loose cohesionless soils are difficult to recover with most drive/push sampling devices unless retainers are used, especially when saturated. 

Materials in this category include saturated sensitive clays, silts and sands, sensitive organic silts, soft clays, unsaturated loose sands and silty 

sands. Very dense soil material is also difficult to penetrate with most drive/push sampling devices. Examples of dense materials would include 

compact tills and weakly cemented soil/rock.  

 

E Numerous types of piston samplers have been developed, but only a few are commercially available; many are effective in sampling 

saturated, cohesive soils, but have varying effectiveness for sampling cohesionless soils. F Denison sampler ratings are for soil sampling 
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configuration with inner barrel advanced ahead of outer rotating core barrel. In the rock coring configuration ratings are same as for double 

tube RBD sampler. 

 

 

3.4 Indices and methods used to indicate degree of disturbance 
 

A wide range of indices and methods have been used to estimate sample disturbance. However, certain 

conditions, such as OCR, soil type and plasticity index, need to be met for every index and method. 

Amundsen et al. (2015) summarizes some indices and methods in Table 4. Regarding peats, no proven 

sample disturbance index/method currently exists.  

 

 

Table 4: Indices and methods of quantifying sample disturbance (Amundsen et al., 2015). 

 
 

The strain experienced to load a specimen back to in-situ effective stress is expressed by εv0. A sample 

quality criterion was proposed by Andresen and Kolstad (1979) based on shallow onshore clay shown 

in Table 5. Excellent sample quality is akin to a εv0 of less than 1, indicating negligible disturbance. It 

is questionable if this criterion can be applied to peats. Furthermore, it was proclaimed by Lacasse and 

Berre (1988) that this criterion was too conservative for the intended onshore clays. The reason this is 

questionable to apply to peats is because a change in pore volume has a greater effect to the skeleton 

structure, the lower the initial pore volume of the sample, thus causing sample disturbance. Therefore, 

this criterion may be applied to soft plastic clays, but likely not reliably to peats.  
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Table 5: Oedometer sample quality criteria (Andresen and Kolstad, 1979). 

 
 

In order to quantify sample disturbance, Lunne et al. (1997) proposed to use the disturbance index, 

represented by the ∆e, when consolidated back to in-situ effective stresses during the triaxial, direct 

simple shear (DSS) or oedometer test, divided by the initial void ratio (e0) denoted by ∆e/e0. Table 6 

shows the categorization of quality types ranging from “Excellent” to “very poor” (Lunne et al., 1997). 

Previously, the change in volumetric strain (εv0) at in-situ vertical effective stress (σv0’) was used to 

measure sample disturbance (Andresen and Kolstad (1979), Lacasse and Berre (1988)). It must be 

noted, that this disturbance criteria (by Lunne et al., 1997) was based on tests carried out on marine clay 

samples with properties: plasticity index 6%–43%, w 20%–67%, OCR 1–4, and depth 0–25 m below 

ground level. Therefore, the soils to be investigated in this thesis (organic clays and peats) should fall 

within these ranges so that the ∆e/e0 may be used with confidence. However, peat will certainly have a 

much higher w than the maximum range stated. Alternatively, the oedometer stiffness ratio, M0/ML, by 

Karlsrud and Hernandez-Martinez (2014) may be used to model disturbance, which relies on the 

maximum constrained modulus in the overconsolidated stress range (M0) and the minimum constrained 

modulus after preconsolidation stress (ML). When disturbance increases with this measure, it signifies 

a denser soil structure caused by volumetric changes during reloading. 

 

Table 6: Proposed criteria for evaluation of sample disturbance by Lunne et al. (1997). 

OCR ∆e/e0 

Very good to 

excellent 

Good to fair Poor Very poor 

1-2 <0.04 0.04-0.07 0.07-0.14 >0.14 

2-4 <0.03 0.03-0.05 0.05-0.10 >0.10 

 

 

Landon et al. (2007) used the bender element test to measure resulting shear wave velocities (Vs) in soft 

clays. In order to quantify the disturbance, the Vs of the sample was measured immediately after the 

sampling procedure in the field (Vvh) and compared to the shear wave velocity of the soil before 

sampling (VSCPTU) with the use of a Seismic Cone Penetration Test (SCPTU) (Landon et al., 2007). The 

established disturbance index based ∆e/e0 was compared to the differences in shear wave velocity, 

shown in Figure 17. Samples are rated based on the following criteria: Very Good to Excellent and Fair 

to Good Quality: Vvh/VSCPTU ≥ 0.60. Poor Quality: 0.35 ≤ Vvh/VSCPTU < 0.60. Very Poor Quality: 

Vvh/VSCPTU < 0.35 (Landon et al,. 2007). In order to validate the use of the shear wave velocities to 

quantify sample disturbance, Vvh/VSCPTU was plotted against ∆e/e0, showing a linear trend (Figure 17(c)). 

In accordance with the ∆e/e0, shear wave velocities show that less disturbance is caused by sampling 

with the Sherbrooke block sampler than with the piston samplers. It was concluded that bender element 

testing serves as a non-destructive, rapid and portable method to determine sample disturbance (Landon 

et al., 2007).  
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Figure 17. Comparisons of different sample disturbance parameters (Landon et al., 2007). 

 

3.5 Using CT scans as a measure of sample disturbance 
 

CT scanning is described by Ladd and DeGroot (2003) as a very cost effective method because it 

enables the separation of poor quality samples from sufficiently undisturbed samples without opening 

the container. This is especially important in expensive sampling operations such as offshore sampling 

or onshore sampling when costly samplers such as the Sherbrooke block sampler or DLDS are involved. 

The degree and nature of sample disturbance via CT scanning can be measured by the following 

identification features: bending near the tube perimeter, cracks due to stress relief (e.g. gas exsolution) 

and voids due to sampling disturbance, often near the ends of the tube. In a paper investigating the 

damage caused to archaeological structures by one-dimensional loading, Ngan-Tillard et al (2016) 

observed the structural changes in peat and organic clays with micro-CT scans. As shown in Figure 18, 

the fibres have compacted together with the surrounding soil matrix compared to the sample before 

one-dimensional loading. However, it is unclear whether and how the orientation of the fibres changed. 

CT scanning is most efficient in mediums with contrasting density distribution, however, due to the 

high w usually encountered in peat, it may lead to insufficient density contrast in images.  

 

 
Figure 18. Micro-CT scans of subvertical rootlets and other plant matter in a 50 mm oedometer sample, (left) before loading 

(in blue) and (right) after loading (in red) which underwent a maximum pressure of 180 kPa (Ngan-Tillard, 2016).  
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4 Methodology, data gathering and 

processing 
 

The methodology, data gathering and processing section describes the approaches used to acquire the 

data necessary to formulate conclusions based on the research questions. Data collection methods were 

carried out in parallel, due to the time-intensive nature of organizing and performing certain methods 

such as the IL oedometer tests and STOWA database collection. In Table 7, the test type(s) conducted 

for each sample and specimen of the SDT database are highlighted. 

 

Table 7: Constituents of SDT database. 

Sample name Specimen 

name 1 

IL 

Oedometer 

test 

Pycnometer 

test 

Bender 

element 

test 

Medical-CT 

scan 2 

Micro-CT 

scan MR 3 

Micro-CT 

scan HR 4 

Sieve 

test 

VN75740-2-2A A1 √ √      

A2 √ √      

VN75740-2-2C A3 √ √      

A4 √ √   √√ 5 √√ 5  

11204108 D1 √ √  

√ 

   

D2 √ √     

VN80625-1-1 D3 √ √     

√ 
D4 √ √   √√ 5 √√ 5 

VN80625-1-2 D5   √     

D6   √     

D7   √     

VN80625-1-3 A5   √     

VN75740-3 -     √    

VN75740-5 -        √ 6    

1 A = Ackerman sampler, D = DLDS 
2 With x and y resolution of 0.3 mm and z (horizontal) resolution of 0.6 mm. Scans were made on the whole block or tube 

sample. 
3 Medium Resolution: 23 microns. 
4 High Resolution: 5 microns. 
5 Indicates two scans were performed, one before and one after the 1D compression test.  
6 Two scans performed, one without removing sample from the Ackerman tube, one after removal from tube. 

 

The methods and apparatus used in this investigation encompass a wide range of length scales, as 

demonstrated by the order within Figure 19. In the figure, the lower boundary next to the stated method 

indicates the order of magnitude of the highest resolution for said method. Meanwhile, the upper 

boundary is the maximal measurement scale at which the method may be applied. For example, the 

micro-CT has a maximum resolution of 5 microns (10-6 magnitude) and the measurements are applied 

over whole specimens which are restricted to the size of a few centimetres in any of the axes (10-2 

magnitude). 
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Figure 19. Scales of measurements and resolutions. 

 

4.1 Radiography 
 

4.1.1 Medical-CT scans 
 

Medical-CT scans are efficient in scanning large soil masses quickly to identify disturbance features 

such as bending near the tube perimeter and density changes within the sample. Therefore, an 

appropriate use for this technique is for qualitative analysis of samples, as quantitative analysis may 

lead to significant errors due to the much lower resolution compared to the micro-CT scanner. The 

resolution for the scans were 0.6 mm in the z axis, which is in the length direction of the tube, and 0.3 

mm in the x and y axes, perpendicular to the tube length, with a scanning kilovoltage of 140 (kV). 

Figure 20 shows the medical-CT scanner of TU Delft used for scanning the block sample and Ackerman 

sample before and after extraction from the tube. The resulting greyvalue intensity of the medical-CT 

scan has Hounsfield units (HU) due to the calibration ability of the device. Images were preserved at 

64-bit to maintain resolution. On the HU scale, a value of -1000 represents air and 0 represents water. 

The range of HU for these images was from -1024 to 2844. 
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Figure 20. Medical-CT scanning of peat in Ackerman tube (left) and  peat DLDS block (right). 

Beam hardening is encountered in CT scanning when the edges of an object return a higher greyvalue 

intensity than the centre of the specimen, even if the material has the same density throughout. This is 

due to the differences in penetration of the spectrum of X-ray energy delivered by the CT scanner, 

especially when highly dense materials in the CT cell absorb the photons before reaching the intended 

material for scanning. In this investigation, this was mitigated for micro-CT scans by housing all 

samples in plastic wrapping sheet, which ensures moisture retention as well. For medical-CT scans, 

beam hardening correction was needed for the scan of the peat sample within the steel Ackerman tube, 

due to the high density stainless steel absorbing excess amount of photons. While beam hardening 

correction by the built-in medical-CT scanner software greatly reduced the effect, as Figure 31 in 

section 5.1.1 shows, beam hardening is still present close to the tube wall. The scans were analysed 

with the use of the image analysis program Fiji, also named ImageJ.  

 

4.1.2 Micro-CT scans 
 

Micro-CT scans were performed on samples before and after consolidation using a Nanotom NF180 x-

ray CT scanner at TU Delft (Figure 21). Due to the high variability in grain size of peats, scans of 

samples with a resolution of 5 μm were made in addition to the standard resolution of 23 μm for this 

investigation. In order to validate the resolution used for micro-CT scanning, a wet-sieve analysis was 

conducted on the same peat subject to IL oedometer testing and scanning, to determine a grain size 

distribution. The highest permissible resolution being determined by the diameter of the specimen, 

resulted in a diameter of 11 mm and 65 mm being used, for the 5 μm and 23 μm resolution scans 

respectively. The resulting micro-CT scan greyvalue intensities are uncalibrated, due to the machine 

lacking the function to do this. This is due to differences in machine requirements between the micro-

CT scanner and the medical-CT scanner, whereby all medical-CT scans must adhere to calibration to 

real life density and micro-CT scanners must not. The scans could then possibly be manually calibrated 

to reference objects in the scan of known density such as air and sand grains. Likewise to the medical-

CT scan, images were preserved at 64-bit images. 
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Figure 21. Nanotom TU Delft micro-CT scanner. 

 

The following summarized procedure was carried out for all micro-CT scans of 23 μm resolution 

detailed in Table 7. As with the medical-CT scans, the micro-CT scans were analysed with Fiji. 

Greyvalue thresholds were used to binarize air-filled pore space and silica grains, in order to isolate the 

peat and water in the scans. A Z Projection was made for the mean greyvalue intensity and standard 

deviation of the column. Following this, 200 concentric circles were created on both Z Projections, for 

which the average greyvalue intensity and standard deviation along the perimeter of each circle was 

calculated as shown in Figure 22. This enabled the creation of a greyvalue intensity vs radius graph, 

which is a proxy measure for sampling densification with increasing radius, with the aforementioned 

standard deviation measure used to calculate the standard error at each of the 200 radii. The 

methodology used within Fiji is presented in Appendix D with greater detail. 

 

 
Figure 22. Concentric circles in Fiji. 
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4.2 SCPTU, MASW and Bender element tests   
 

In order to measure the in-situ VSCPTU, seismic cone penetration tests (SCPTU) were deployed in Gouda 

(Figure 23) using both the Geomil and APvdBerg acquisition systems. Two batting beams, each fitted 

with two sledgehammers of 10 kg) were placed at 2 m and 5 m from the cone of the CPT rig in order 

to provide the necessary seismic wave. A minimum of three readings were taken per beam, per interval 

of 0.5 m, until the sand layer at -11 m NAP was reached. For this location, the soil layer interpretation 

from previous CPT tests were: Topsoil from NAP -2.5 m to NAP -3.5 m, followed by clay until NAP -

4 m, peat till NAP -8 m and organic clay until the sand layer at -11 m NAP. Unfortunately, the 

APvdBerg system had a fatal equipment failure upon reaching the NAP -5.0 to -5.5  m interval, 

therefore, no data was recorded with this system lower than this depth.  

 

 

 
Figure 23. CPT rig with SCPTU modifications. 

 

As a mean to validate the SCPTU tests, Multichannel Analysis of Surface Waves (MASW) were carried 

out at the same site in Gouda, as displayed in Figure 24. The shear wave velocities resulting from this 

method were compared to the shear wave velocities from the SCPTU tests. In this array, 48 vertical 4.5 

Hz geophones were spaced at one metre from one another. The geophones used in this operation had a 

distortion of less than 0.3% for the measured shear wave velocities in the raw seismograph. The reading 

interval was conducted from a mobile source every six metres, parallel to the geophone array. Similarly, 

the SCPTU set-ups utilized a sledgehammer of 10 kg as the source of seismic waves, with five seismic 

input signals made per interval to constitute an average.  
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Figure 24. Multichannel analysis of surface waves (MASW) at the site in Gouda. 

 

Before conducting the bender element tests, samples were first saturated to a B-value of at least 0.97, 

which is used to evaluate the degree of saturation of the specimen. Subsequently, they were consolidated 

back to its in-situ σv within a conventional triaxial rig, at the laboratory of geotechnical firm Wiertsema 

& Partners (Figure 25). The height and diameter of the samples before consolidation were 10 cm and 5 

cm, respectively. An input wave with a period of 0.2 ms and a voltage of 14 V was used to induce the 

resulting output wave during the bender element tests. The peak-to-peak method was used in order to 

determine the Vs, which entails measurement of the time difference between the transmitted peak and 

the received peak. An average Vs per specimen was produced based on 10 Vs measurements.  

 

 

 
Figure 25. Bender element set-up within triaxial rig. 
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4.3 IL oedometer tests 
 

In addition to consolidation data collection from databases, different tests were carried out on newly 

sampled Ackerman and DLDS peat and organic clay samples for this study, from sites in Vlist and 

Gouda, which formed part of the SDT database. The IL oedometer test for this investigation had to 

follow the same procedure as used in the STOWA’s database oedometer results in order to minimize 

bias in the methodology. These IL oedometer guidelines in STOWA’s database come from the Dutch 

‘Macro Stability Schematic Guide’ (Ministry of Infrastructure and Water Management, 2016). Firstly, 

the volumetric weight of the sample was determined by measurement of the soil mass and volume of 

the sample, followed by calculation of the in-situ σv’. After determination of the in-situ σv’ the sample 

was subject to, specific loading steps were used depending on the calculated in-situ σv’, in conform with 

Table 8. As shown in Figure 26, the IL oedometer was connected to a displacement transducer (and 

computer), which allows for continuous measurements, with a reading interval of 10 seconds.  

 

Table 8: Stresses per loading step, standardized to the σv’ (Ministry of Infrastructure and Water Management, 2016). 

σ'vi 

[kPa] 

Loading step 

1 2 3 4 5 6 7 8 9 

<50 0.25 0.5 1 2 4 2 4 8 16 

>50 0.25 0.5 1 2 4 2 4 10  

 

From each sample, two specimens were prepared with varying specimen height of 19.5 mm and 29.5 

mm. Specimens from Ackerman samples were cut from the mid-point of the tube height, using a sharp 

knife for peats and a wire saw for organic clays. The Ackerman specimens underwent negligible 

additional disturbance during the cutting procedure with the cutting ring, due to the near identical inner 

diameter of ~65 mm used for both devices.  

 

 
Figure 26. Incremental loading oedometer cell used to consolidate samples at TU Delft. 

 

After completion of the last loading step, the data was processed using methods from the Dutch 

guidelines for oedometer test execution and interpretation (CUR, 2005). Firstly, for each specimen, the 

time needed to reach 100% primary consolidation (t100) for each loading step was found with the use of 
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the Casagrande and Taylor methods, which is needed in order to calculate the strain and e, as shown in 

Figure 27. The intersection point between the tangent of the inflection point of the load step and the 

tangent of the straight portion of the lower part of the curve. This was often non-trivial and subject to 

bias, due to the nature of the high compressibility of peat settlement, which causes the interface between 

primary and secondary consolidation to be difficultly recognizable. In order to add certainty to this 

measurement, the alternative Taylor √𝑡 – method was used. Occasionally, the difference in t100 values 

between the Casagrande and Taylor methods was one order of magnitude. The effect of this is further 

discussed in section 5.3.1. Then, as presented in Figure 28, the Casagrande method was used to find the 

pre-consolidation pressure, which is necessary to calculate the OCR. The pre-consolidation pressure 

with this method is indicated by the intersection point of the bisector line of the tangent at the point of 

highest curvature with the tangent line of the curve after the recompression step. Subsequently, the RR 

was derived, which is defined by equation 2, calculated between loading step 6 and 7. 

 

𝑅𝑅 =  
∆𝜀

∆ log(𝜎′
𝑣)

     (2) 

 

 

 

 
Figure 27. Settlement graphs of peat sample A4, loading step 8 on a Casagrande semi-log time scale (top) and Taylor 

square-root time scale (bottom) to find the t100). 
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Figure 28. Casagrande method to find pre-consolidation pressure of the sample A4. 

 

4.4 Pycnometer test, oven-dry method and wet-sieve analysis 
 

In order to determine the specific gravity, also known as relative density (G) and dry volumetric weight 

(γd), the pycnometer test and oven-dry method were carried out respectively. These tests enabled the 

use of equation 3 to determine the e0, used to produce the ∆e/e0. The helium gas-based Ultrapycnometer 

1000 device (Figure 29) was used on dried soil, which had been dried in an oven at 70°C for at least 24 

hours. Then, the soil was weighed and subsequently placed in the container of the device and ten volume 

measurement runs were carried out per specimen by the device. Similarly, the oven-dry method was 

used at 70°C for at least 24 hours, at a known prior volume, then weighing the soil, followed by the use 

of equation 4 to determine the dry volumetric weight. The temperature of 70°C was used for the 

prolonged period of time in order to not risk combustion of the organic material in the samples. Sample 

weighing had to be done swiftly as to avoid an increase in sample weight as the peat absorbs humidity 

from the surrounding air. 

 

       𝑒0 =
𝐺∗𝛾𝑤−𝛾𝑑

𝛾𝑑
     (3) 

 

      𝛾𝑑 =
𝑊𝑑

𝑉
     (4) 
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Figure 29. Ultrapycnometer 1000 device. 

 

A wet-sieve analysis was performed on peat, with the aim of creating a grain size distribution and 

providing an indication of the resolution needed for CT scanning. This analysis was conducted with the 

auto-analyser at the laboratory of Wiertsema & Partners on sample VN80625-1-1. 

 

4.5 DLDS and STOWA Database 
 

Since only one DLDS rig exists, which has been operational since 2017, the available data is limited. 

Additionally, the data needs to be applicable to this thesis, whereby a IL oedometer tests needs to have 

been carried out. The same set of geotechnical parameters were filtered from the DLDS database as 

from the STOWA database. 

 

In the Netherlands, regional waterboards contract geotechnical sampling companies to collect 

geotechnical data and store it in STOWA databases. For this investigation, waterboards of the 

Netherlands were approached to provide access to these databases. If it was not possible to establish 

contact with a waterboard representative, the database was received directly from the geotechnical 

sampling company involved in this thesis, Wiertsema & Partners, however, in these cases the data was 

anonymised to protect the contract laws between said organizations.  

 

First of all, rows not including any IL oedometer data were filtered out, followed by the filtering of 

rows which did not include the appropriate soil types for this investigation. Secondly, all forms of peat 

classified soil data was retained, in addition to organic clays, which had humousity as a secondary soil 

fraction, ranging from weakly organic (h1) to very strongly organic (h4), according to the standard 

NEN5104 (NEN, 1989). This antiquated standard was used because the STOWA database has 

accumulated data based on NEN5104 (NEN, 1989) for the past decades. In order to produce the ∆e/e0 

parameter by Lunne et al. (1997), the necessary ∆e to in-situ σv was extracted from original PDF files 

(containing consolidation graphs and supplementary data) used to fill in the parameters of the STOWA 

database. Thirdly, the OCR had to be computed, as necessary for the clays tested by Lunne et al. (1997). 

For this, the original PDF files were again investigated, since the pre-consolidation stress had to be 

interpreted from the graphs showing σv’ against strain. Lastly, the ∆e/e0 was computed and relationships 

between the parameters within Figure 2 were investigated. 



       

32 
 

5 Data analysis and results 
 

This section explains how the data was analysed and the subsequent results were obtained. This section 

is subdivided into the methods used for soil disturbance characterization. A summary of test types 

performed on each sample and specimen is presented in Table 7. 

 

5.1 Non-destructive disturbance determination methods 
 

5.1.1 Medical-CT scans 
 

Both quantitative and qualitative analyses were performed on the CT scans. Due to peat often falling in 

the same density range as water, it was difficult to distinguish between the two different mediums during 

image analysis in both medical- and micro-CT scans. Brighter greyscale shades on CT scans signify 

material with higher density.  

 

Figure 30 (left) shows a cross-section of a medical-CT scan slice. Noticeably, cracks are prevalent in 

the upper half of the sample, with this observation also occurring throughout the remainder of the CT 

scan slices. This is believed to be due to a combination of the following factors: stress relief, gas 

exsolution and water migration. The reason these types of disturbances occur is due to the intermediary 

stage between removing the soil in blocks from the DLDS tube and laboratory testing, whereby the 

samples are wrapped in plastic and aluminium foil as described in section 2.3. In addition, while peat 

is a coarse material, pore water can easily migrate from the top of the block to the bottom. Due to 

insufficient lateral support and handling of the sample, distortion occurs at the edges of the block. A 

follow-up scan should be made of a full DLDS tube in order to confirm that this is only limited to the 

block format. When this is combined with a higher resolution scan, the same method may be applied as 

described in section 4.1.2 to determine the radial density differences (tube wall edge effect) as for the 

Ackerman sample. Numerous characteristic constituents of peat samples can be identified in Figure 30, 

such as a partially decomposed branch (label ‘a’), silica grains (label ‘b’) and a macro pore (label ‘c’).  

 

  
Figure 30. Cross-section (left) and top view (right) of medical-CT scan slice of peat DLDS block sample 11204108. 

Scans were made before and after removing an Ackerman sample from its respective thin-walled tube. 

Figure 31 shows the same slice for comparison, whereby changes in structure and available pore space 
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can be noticed. While structure stayed the same in many slices, there were instances such as in Figure 

31 which show swelling and rearrangement of structure. Using ImageJ to quantify the change in total 

sample volume, it was established that the total volume increase of the sample was 3.59% after 

extraction from the tube. 

 

 
Figure 31. Top view of the same Ackerman sample before extraction from tube (left) and after extraction from tube (right). 

 

5.1.2 Micro-CT scans 
 

As with the medical-CT scans, several characteristic features of peat were identified in the micro-CT 

scan of Figure 32. Label ‘a’ represents a partially decomposed twig; label ‘b’ is silica mineral present 

in peat, higher density material is evident due to the white points; label ‘c’ shows an air-filled void; 

labels ‘d’ demonstrate regions with brighter coloured areas closer to the side walls of the Ackerman 

tube, indicating an increased local densification, i.e. disturbance. These scans were made with the 

specimens after extraction from the tube, therefore it is not possible to establish whether this slight 

disturbance occurred due to the extraction procedure. The wet sieve analysis conducted on sample 

VN80625-1-1, presented in Appendix C shows that ~24% of the grains by weight were below 23 μm 

of grain diameter, which is the maximum possible resolution of the micro-CT scanner for the size of 

these specimens.  

 

 
Figure 32. Cross-section of single CT scan slice of peat specimen A4 before testing. 

The naming of the specimens in this section is derived by the sampling method and specimen number, 

i.e. ‘A’ stands for Ackerman specimen and ‘D’ for DLDS specimen. In the micro-CT scans, the 
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additional ‘pre’ and ‘post’ indicate whether the scan was made before or after 1D compression testing. 

As detailed in the procedure of section 4.1.2, concentric circles of the specimen scans in Fiji averaged 

the greyvalue intensity over increasing distance from the centre of the specimen. The results are plotted 

in Figure 33, with Table 9 showing the differences of the disturbed perimeter effect. The increase in 

greyvalue intensity (%) was computed from the increase of the mean greyvalue intensity over the first 

37% of the radius to the peak greyvalue intensity. The 37% distance was established arbitrarily, as it 

was observed that after this the specimens showed a constant increase in greyvalue intensity. During 

1D compression, specimen A4post experienced a maximum strain of 45.9% and specimen D4post 

experienced a maximum strain of 75.5%, with both specimens having a height of 29.5 mm. Naturally, 

these strain levels were not preserved when the samples were unloaded, the samples swelled, refilling 

some of the pore space with air, which has a significantly lower density than water. Due to this process, 

coupled with evaporation of water from the specimen until the scan could be made, is the reason that 

A4post has a lower greyvalue intensity profile than A4pre in Figure 33. While the greyvalue average 

intensity is higher after 1D compression for the DLDS sample in Figure 33, when observing the 

difference between the air peaks and peat peaks reported in Table 17 of Appendix D, it is evident that 

the difference between peaks is less for D4post, which signifies a decrease in density as with A4post. 

The increase in greyvalue intensity (%) is higher for the specimens after the 1D compression test when 

compared to the scan before 1D compression, with the Ackerman sample increasing from 10.97% to 

12.28% and the DLDS from 1.49% to 1.82%, as presented in Table 9. However, this mainly 

demonstrates that Ackerman specimens increase radially in greyvalue intensity, more so than the DLDS 

specimens. Additionally, the effect of densification at the perimeter of D4pre (1.49%) and D4post 

(1.82%) may be caused by sample preparation with the oedometer cutting ring, which the Ackerman 

samples may have also been subject to, in addition to the tube wall densification.  

 

A disadvantage from the micro-CT scans is that specimens A4post and D4post were left uncompressed 

for several days after completing their respective IL oedometer test, before the CT scan took place. As 

previously mentioned, this caused swelling, which means that these results underestimate the density 

difference as a function of distance to the centre of the specimen that would be experienced under 

natural conditions. However, this was necessary, as a micro-CT scan at the required resolution takes 

more than one hour to scan and reconstruct, and a large rate of swelling is not permissible during the 

scanning as the image might be distorted due to the changing sample volume. Although difficult to 

observe in Figure 33, a trough is present in specimen D4pre, halfway through the total specimen radius, 

which is due to the presence of a vertically aligned twig as shown in Figure 34. This is an air-filled 

twig, which is recognized by the darker shading within it, therefore causing a decrease in greyvalue 

intensity. Higher density soil encountered towards the wall of the consolidation cell during 1D 

compression testing, regardless of sampling method used, is due to the friction between the wall and 

the soil as detailed by van Essen (2021). In the paper, it is suggested to decrease the load value used in 

calculations of IL oedometer tests by 7% for specimens of diameter 63 mm. This is due to the load not 

being fully transferred to the sample, therefore the true load on the sample is less than the load applied. 

The friction may create abrasion, which will in turn cause a breakdown of fibres and grains in the peat 

at the interface between the wall and the sample, thus causing a higher density in this zone. In future 

studies, it would be of interest to incorporate this newly established 7% reduction on the load values in 

the IL oedometer section of the SDT database, to observe any trend changes when compared to other 

parameters.  
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Figure 33. Radial change of greyvalue intensity in 8-bit. 

 

 
Figure 34. Top view of specimen D4pre with vertically aligned twig, shown by red circle. 

 

 

Table 9: Radial densification of scanned specimens. 

 
A4post2 A4pre3 D4post2 D4pre3 

Mean greyvalue intensity1 39.31 53.45 43.38 38.32 

Peak greyvalue intensity 44.14 59.32 44.17 38.89 

Increase in greyvalue intensity 

from mean to peak (%) 

12.28 10.97 1.816 1.489 

1Taken over the first 37% distance from the centre of the specimen. 
2 ‘post’ indicates that the scan was made after 1D consolidation. 
3 ‘pre’ indicates that the scan was made before 1D consolidation. 
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5.1.3 SCPTU, MASW and bender element tests 
 

As shown in Figure 35, the difference in the Vs,b between the Ackerman and DLDS techniques is 

considerable. At the sampling depth in Gouda, the Vs,b of the Ackerman sample was 55.2 m/s and had 

a 65.4% difference to the in-situ VSCPTU  (28 m/s). For the DLDS sample, the Vs,b was 48.9 m/s, equalling 

a difference of 54.4% to the aforementioned in-situ VSCPTU. The associated standard error of the mean 

(SEM) [relative standard error] of the bender element test for the Ackerman and DLDS techniques are 

0.12 m/s [0.23%] and 0.87 m/s [1.8%] respectively. The larger error in the DLDS is due to the fact that 

three samples were prepared from the same DLDS block at the same height, while only one bender 

element test could be done per Ackerman tube due to the diameter constraint. For the Ackerman sample, 

the error is based on the three output signal measurements of the singular bender element test, rather 

than three independent bender element tests as done with the DLDS samples. This creates an artificially 

lower relative standard error for the Ackerman sample, which is expected to have an error of the same 

magnitude as the DLDS sample, if it were possible to make multiple bender element tests from one 

Ackerman tube as with the DLDS block. The mean Vs,b findings are in contrast to the results from 

Landon et al. (2007), due to the boundaries of the Vvh/VSCPTU parameter in the study. In the paper, sample 

quality is rated based on the following criteria: Very Good to Excellent and Fair to Good Quality: 

Vvh/VSCPTU ≥ 0.60. Poor Quality: 0.35 ≤ Vvh/VSCPTU < 0.60. Very Poor Quality: Vvh/VSCPTU < 0.35. By this 

measurement system, the Ackerman sample Vvh/VSCPTU = 1.98 and the DLDS Vvh/VSCPTU = 1.75, 

implying that the DLDS sample is more disturbed than the Ackerman sample. The Vvh/VSCPTU method 

developed by Landon et al. (2007) imply that Vs are lower in samples than in-situ. However, this is due 

to the fact that in the methodology described, samples were not reconsolidated back to in-situ stress, 

with the aim of developing a rapid method for in-field disturbance determination. The in-field bender 

element results were normalized to laboratory reconsolidated bender element results showing 

accordance in behaviour (Landon et al., 2007). If suction can be effectively applied to samples during 

sampling, the effective isotropic stress remains constant. In the case that suction is not applied or not 

applied appropriately to the sample, these in-field samples for testing will have been unloaded from 

their in-situ stress state and not reconsolidated, therefore the soil grains are less compacted and pore 

space is increased. Since shear waves are transmitted at higher velocity through soil skeleton than 

through voids, a decrease in Vs is the result. Therefore, a more appropriate measure for the disturbance 

in this study is the percentage difference between in-situ and laboratory shear wave velocities, as 

reported earlier in this section. Importantly, the method developed by Landon et al. (2007) was 

concluded to be suitable for non-organic clays only. Shear waves cannot propagate through water, while 

peats are known to have very high water contents. Hence, shear waves take a longer path from the 

seismic source to the receiver, leading to lower velocities, but more importantly a degree of error due 

to the unpredictable “jagged” path that may happen. This observation of decreasing shear wave 

velocities with increasing water content in peat was also noted by Dong (2016).  
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Figure 35. Shear wave velocities of DLDS and Ackerman samples with SCPTU and MASW profiles. 

 

A source of random error for the SCPTU can be attributed to the relatively large interpolation distance 

because of the sampling interval of 0.5 metres. In addition, a systematic error may lie within the SCPTU 

Geomill system. While the distance component of the shear wave velocity measurement of the SCPTU 

is highly precise and accurate, the time interpretation has certain ambiguity, especially when high levels 

of noise are involved, as is the case with seismic analyses. The location was within 15 metres of a two 

way road with active car traffic, which will have had an effect on the seismic readings for both the 

SCPTU and MASW. However, since the signal to noise ratio decreases with increasing depth (as the 

wave amplitude decreases), the relatively shallow acquisition depths in this investigation are 

favourable. SCPTU measurements were conducted by both the Geomill and APvdBerg systems. Due 

to equipment failure of the APvdBerg system, only the VSCPTU until the 4.5 – 5.0 m depth interval were 

measured, however the discrepancy between the two systems were considerable up to this depth as 

shown in Table 14 in Appendix B.  

 

Due to lateral heterogeneity of soil, especially for peats, a MASW was performed at the site to validate 

shear wave velocities from the SCPTU. In Figure 36 (a), the spatial shear wave velocity map of the site 

in Gouda is shown, with the SCPTU performed at the zero mark of the horizontal distance. The 

coordinates from (0, 6.7) to (0, 7.1) in Figure 36 (a) is the interval of interest from where the samples 

were taken, for which the MASW shows a Vs of ~60 m/s. This means there is a 53.3% underestimation 

by the SCPTU value of 28 m/s, compared to the MASW Vs. Moreover, Figure 36 (b) shows a confidence 

level of ~100% in this zone, which indicates very high reliability of the modelled Vs result compared to 

the measured Vs. The confidence map in Figure 36 (b) is a sensitivity analysis which aids in determining 

how well the model fits the measurements. Moreover, the confidence level is defined by the sensitivity 

of the modelled dispersion curve to the Vs change at a point in the cross-section. The dispersion curve 

is determined in two steps, firstly a dispersion image is generated from the raw seismic field record 

using a wavefield transformation method, followed by extraction of the fundamental-mode dispersion 

curve from the dispersion image. 
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Figure 36. Shear wave velocity map as a function of surface distance and depth (1) and corresponding confidence map in % 

(2). 

The relationship between the initial shear modulus (G0), density (ρ) and Vs is shown in equation 5. As 

the Vs is squared, the G0 is more dependent on changes in this parameter. The results show that the 

percentage difference between the two samplers used varies by 12.9%. At the same time, as the density 

between the two samplers is approximated by the increase in greyvalue intensity measures as shown in 

Table 9, the difference between A4pre and D4pre in this regard is 9.5%. While this does not demonstrate 

that the ρ and Vs must increase equally as a function of disturbance, due to methodological differences 

further discussed in chapter 6, it does show the implication of using an overestimated Vs for G0. 

 

𝐺0 =  𝜌 ∗ 𝑉𝑠
2     (5) 

 

 

5.2 1D consolidation results from databases 
 

5.2.1 IL oedometer results from SDT Database 
 

The general parameters for the samples from the Sample Disturbance Test (SDT) dataset, such as soil 

type, sampling location and depth are displayed in Table 10. The extended version of this dataset 

including both properties and geotechnical parameters of the dataset can be found in Appendix E.  
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Table 10: General information of IL oedometer tests in SDT database. 

Sample name Specimen 

name 

Soil type Sampling 

technique 

Sampling 

location 

Specimen 

height (mm) 

Depth1 

(m) 
γw 

(kN/m3) 

In-situ σv’ 

(kPa) 

11204108 D1 Peat DLDS Vlist 29.5 1.40 10.12 0.17 

11204108 D2 Peat DLDS Vlist 19.5 1.40 10.12 0.17 

VN75740-2-2A A1 Organic 

clay 

Ackerman Vlist 29.5 2.75 

 

15.07 13.94 

VN75740-2-2A A2 Organic 

clay 

Ackerman Vlist 19.5 2.78 15.07 13.94 

VN75740-2-2C A3 Peat Ackerman Vlist 19.5 2.50 

 

11.08 9.70 

VN75740-2-2C A4 Peat Ackerman Vlist 29.5 2.53 11.08 9.70 

VN80625-1-1 D3 Peat DLDS Gouda 19.5 5.06 

 

9.5 41.87 

VN80625-1 D4 Peat DLDS Gouda 29.5 5.06 9.5 41.87 

1Depth below topsoil relative to NAP 

 

The e0  for the samples intended for 1D compression testing were determined from the γd (denoted as 

average density in Appendix E), computed experimentally by the pycnometer from the input mass and 

calculated volume. From each sample, specimens of different heights were loaded in 1D consolidation, 

whereby the resulting settlement was found to be proportional to the initial height of the specimen, as 

dictated by Terzaghi’s consolidation theory.  

 

Samples A1 and A4 are Ackerman specimens of equal dimensions but differing soil descriptions. As 

seen in Table 10, A1 is an organic clay specimen while A4 is a peat specimen. These were from the 

same site in Vlist and have comparable depths. This is of use to establish differences in consolidation 

behaviour and resulting consolidation parameters between organic clays and peats, which vary in 

organic content percentages. The stress-strain plot from the respective IL oedometer tests are shown in 

Figure 37. The RR using the Casagrande method for A1 and A4 are 0.020 and 0.030 respectively. Table 

11 shows consolidation parameters processed from the SDT database. It is important to note that the 

∆e/e0 was developed for use with data from CRS oedometers rather than data from the IL oedometer.  

 

 

Table 11: Geotechnical parameters from SDT IL oedometer tests. 

Specimen 

name 

G ∆e/e0 

(%) 

Pre-consolidation 

stress (kPa) 

OCR Initial volumetric w 

(%) 

RR 

(Casagrande) 

RR (Taylor) 

D1 1.60 8.55 11.2 2.00 305 - 2 0.056 

D2 1.60 8.99 11.2 2.00 305 - 2 0.104 

A1 2.33 8.26 28.0 2.01 173 0.020 0.018 

A2 2.33 7.29 32.0 2.30 173 0.016 0.014 

A3 1.74 6.35 15.0 1.55 308 - 2 0.028 

A4 1.74 5.26 21.0 2.16 308 0.030 0.027 

D3 1.28 35.40 20.9 - 1 254 0.045 0.012 

D4 1.28 39.40 31.5 - 1 254 0.260 0.217 

1 The OCR for these specimens was less than 1, indicating either a strong change of the water table or a diminutive yield stress 
2 Incalculable RR due to erroneous t100 values 
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Figure 37. Stress-strain behaviour of specimens A1 and A4. 

 

Atypical bending was observed in the void ratio to σv’ plot for specimen D4 (Figure 38) (similarly to 

D3), as the curvature was insufficient to establish a pre-consolidation pressure using the methods 

detailed in section 4.2. A possible explanation for this result is that the yield stress is less than 10 kPa. 

Contrastingly, the stress on the soil might have been exceeded the yield stress due to swelling during 

transportation. Following this reasoning, in Table 11 the ∆e/e0 gives the impression that this is a highly 

disturbed specimen. 

 

 
Figure 38. Void ratio vs σv’ plot of specimen D4. 

 

5.2.2 Summary of disturbance ratings in SDT database 
 

The summary of quantitatively determined disturbance levels experienced by specimens forming part 

of the SDT database, including the non-destructive methods, are reported in Table 12.  
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Table 12: Summary of SDT database disturbance ratings by parameter. 

Sample name Specimen 

name 1 

Micro-CT scan 

method (%) 2 

Shear wave velocity 

method (%) 3 

RR (Taylor) 4 ∆e/e0 (%) 5 

VN75740-2-2A A1   0.018 8.26 

A2   0.014 7.29 

VN75740-2-2C A3   0.027 6.35 

A4pre 10.97  0.027 5.26 

A4post 12.28  

11204108 D1   0.056 8.55 

D2   0.103 8.99 

VN80625-1-1 D3   0.012 35.40 

D4pre 1.49 
 

0.217 39.40 

D4post 1.82 

VN80625-1-2 D5  

54.4 

  

D6    

D7    

VN80625-1-3 A5  65.4   

1 A = Ackerman sampler, D = DLDS, ‘post’ indicates that the scan was made after 1D consolidation, ‘pre’ indicates that the 

scan was made before 1D consolidation. 
2 Determination as shown in Table 9. 
3 Determined by the percentage difference between specimen and in-situ shear wave velocities, discussed in section 5.1.3.  
4 As determined by equation 2. 
5 ∆e determined with void ratio vs stress plots, e0 determined with the supplemental pycnometer test. 

 

 

5.2.3 STOWA and DLDS databases 
 

Typically, the ∆e/e0 is seen plotted against depth, however, in this investigation it is graphed on a ∆e/e0 

vs in-situ σv plot, as seen in Figure 39. The range of OCR for the STOWA database was from 0.2 to 8, 

however, 69% of the OCR values fall within the 1 to 2 OCR range. These soils with an OCR of less 

than 1 indicate underconsolidation, implying that the pre-consolidation pressure is less than the σv’. 

However, the more likely cause is the inaccuracy of the yield stress used in the calculation, due to the 

subjectivity of observation bias, similarly to the discussed method for pre-consolidation pressure 

determination in section 4.3. The horizontal blue lines in Figure 39 indicate the quality boundaries as 

presented by Lunne et al. (1997) for clays with an OCR between 1 and 2. For this dataset, it indicates 

that 37% of Ackerman samples fall within the fair to excellent categories, an ∆e/e0 below 7%. All DLDS 

samples were under 4%, therefore ranked as “Very Good to Excellent” for sample quality. In addition, 

the trend is limited to the two bands seen in Figure 39, which indicate that at higher in-situ σv, it becomes 

increasingly difficult to attain Ackerman samples with an ∆e/e0 below 7%. The suitability of one 

parameter on another in a trend may be gauged with the use of Pearson’s correlation coefficient ‘r’, 

with its mathematical expression given in equation 6. A value of 1 for Pearson’s ‘r’ indicates a perfect 

linear relationship, a value of zero demonstrates no correlation and -1 shows a perfect negative 

correlation. While more DLDS results are needed at higher in-situ σv comparable to those of the 

Ackerman results, the ∆e/e0 vs in-situ σv relationship was established for the combined DLDS and 

STOWA databases with a Pearson’s ‘r’ of 0.73.  
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𝑟 =
∑ (𝑥𝑖−�̅�)(𝑦𝑖−�̅�𝑛

𝑖=1 )

√∑ (𝑥𝑖−�̅�)2𝑛
𝑖=1 ∑ (𝑦𝑖−�̅�)2𝑛

𝑖=1

    (6) 

 

With: xi = x-variable values of dataset 

x̄ = mean of x-variable values 

yi = y-variable values of dataset 

ȳ = mean of y-variable values 

 

 

 
Figure 39. Logarithmic plot of ∆e/e0 vs in-situ σv for STOWA and DLDS databases. The blue lines are the specimen quality 

levels as established by Lunne et al. (1997), with the zone below the bottom-most line described as “Very good to excellent”, 

the next zone as “Good to fair”, followed by “Poor” and the zone above the top-most line being “Very poor” quality. The 

parallel red lines indicate the region which the trend is observed to behave in. 

 

The relationship explored in Figure 39 was further investigated by splitting the ∆e/e0 into its 

components, as shown by the plots in Figure 40. As observed, the e0 appears to have a negative 

correlation with σv, and e0 for DLDS peat samples are higher than for Ackerman peat samples. 

Meanwhile, the ∆e has a random scatter for all constituents of the legend in the plot. This demonstrates 

that the normalization factor of the disturbance index, the e0, biases the disturbance index when 

quantifying the disturbance in peats because a wide range of e0 is possible for this type of soil, as the e0 

is influenced by the highly variable water content levels in peats, while the marine clays for which this 

index was developed for have a much smaller range for e0.  
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Figure 40. In-situ σv vs e0 (left) and in-situ σv vs ∆e (right).  

 

Following this, the influence of w on RR was plotted in Figure 41. While the CR is mainly used for 

engineering design applications involving settlement of soil, the RR is used in specific applications 

concerning soils of high OCR. As stated by Pirouzi and DeGroot (2019), the RR is strongly correlated 

with sample quality for clays, whereby the geotechnical parameter increases with more disturbance. 

Nevertheless, it is a complex parameter. While the maximum w in the DLDS database is 1183% based 

on 25 data points, the maximum w for Ackerman samples in the STOWA database is 721% based on 

398 data points. In addition, even though organic clay shows a linear trend on the w (%) to RR plot, 

peat sampled by either the DLDS or Ackerman samplers show no correlation between these parameters. 

The relationship for organic clays is approximated with the linear equation 7. The adjusted R2 (equation 

8) is often used in conjunction with Pearson’s ‘r’, and it is a statistical tool used to quantify the linear 

fitting capability of a trendline. The Pearson’s ‘r’ and adjusted R2 value are 0.849 and 0.718 

respectively. For this linear relationship, the standard error for the slope and intercept were 110 and 

3.82 respectively. 

 

𝑤 = 1812 ∗ 𝑅𝑅 + 7.44     (7) 

 

 

𝑅𝑎𝑑𝑗
2 =  1 −

𝑅𝑆𝑆/𝑑𝑓𝐸𝑟𝑟𝑜𝑟

𝑇𝑆𝑆/𝑑𝑓𝑇𝑜𝑡𝑎𝑙
     (8) 

      

 

With: 

 𝑅𝑆𝑆 =  ∑ (𝑦𝑖 − �̂�𝑖)2𝑛
𝑖=1  

 𝑇𝑆𝑆 = ∑ (𝑦𝑖 − �̅�𝑖)2𝑛
𝑖=1  

 ŷ = predicted value of y 

 ȳ = mean of y-variable values 

 yi = y-variable values of dataset 

 dfError = the error of the degrees of freedom 

 dfTotal = the total number of degrees of freedom 

 

Due to the higher fraction of heavy minerals in clay, the relative density was higher for organic clay 

than for peat, as shown in Figure 42. An inverse relationship was observed as an increasing relative 

density resulted in an increased likelihood of a low RR, although this relationship was weaker, with a 

linear Pearson’s ‘r’ of -0.75. This relationship can be explained by the RR dependence on strain, as 
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presented in equation 2. The dependence is such that the strain depends on the available pore space and 

w, which is lower for samples of higher relative density. 

 

 
Figure 41. w vs RR plot. 

 

 
Figure 42. RR vs specific density plot 

 

With increasing w a tendency of decreasing ∆e/e0 and a decrease of its variability was identified in 

Figure 43 (right). This trend can be explained by the much higher e0 values typically found in peat. 

Likewise, the decreasing variability of ∆e/e0 in Figure 43 (right) with increasing w is due to the greatly 

increasing denominator in the disturbance index. Alternatively, the relationship can be explained by the 

fact that ∆e/e0 relies on the change in pore volume. As disturbance increases, the ability to swell and 

thus regain pore volume decreases, which results in a lower measure of w. The low ∆e/e0 variability in 

DLDS peats is likely due to the restriction to sampling in shallow soils. When disturbance parameters 

∆e/e0 and RR are plotted against each other, as presented in Figure 43 (left), no agreement can be seen 

between them. This is in part due to these parameters being calculated from different phases of an IL 

oedometer test. Specifically, it is because the RR directly depends on both the σv’ and ∆ε, while ∆e/e0 

depends only on the ∆ε.  
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Figure 43. ∆e/e0 vs water content (left) and ∆e/e0 vs RR (right) plots. 
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6 Discussion 
 

This thesis has used destructive and non-destructive methods to quantify disturbance in peats and 

organic clays. Peat remains a difficult soil to sample and performance of consistent 1D compression 

testing is challenging. Moreover, the difficulty of these operations increases with higher fibrousity, as 

with ‘woody’ peat (peats containing a high fraction of lightly decomposed twigs or branches) samples, 

which can cause jamming of the loading plate until the twig snaps due to the load. This sudden load 

transfer to the pore pressure greatly influences parameters derived from compression tests. In order to 

mitigate this, it is recommended to use a large consolidation cell, such as the Rowe consolidation cell 

due to the large compression potential of peat, which was not available for this investigation. 

Additionally, the diameter of these cells should be between 150 and 250 mm. However, this is not 

possible for Ackerman samples due to the diameter constraint of the tube, but different consolidation 

cell diameters may be used for DLDS specimens in future studies. The recommendation of using the 

conventional diameter to height ratio (D/H) range of three to four for oedometer specimens is not 

appropriate due to the aforementioned high compressibility of peat and potential presence of wood 

chips, therefore a D/H range of one to two is recommended. Additionally, peat is a sensitive soil to 

handle due to its low shear strength and high compressibility potential in an unconsolidated state. 

Adding to this fact, the DLDS is mostly deployed in shallow soils which have a very low σv’. Specimen 

loading in IL oedometer was challenging at times with these low σv’ and low volumetric weight of 

samples, due to the old equipment available. A Large Direct Simple Shear Apparatus (LDSSA) and 

Large Diameter Triaxial Test (LDTT) have been developed by Deltares (Luijendijk, 2016) which 

utilizes samples from the DLDS. Therefore, alternatively to the proposed Rowe consolidation cell, the 

development of a new type of consolidation cell should be pursued having the diameter of a DLDS 

sample, i.e. 40 cm, ideally with CRS oedometer compatibility. In addition, it is often recommended by 

geotechnical sample preparation guidelines, such as the Manual of Soil Laboratory Testing (Head and 

Epps, 2011), to remove wooden lumps from samples, however this would not only induce disturbance 

to the sample, but also not represent in-situ conditions. This is inappropriate practice, and in addition, 

laboratory guidelines often allow filling of gaps in an oedometer cell with leftover soil pieces from the 

sample. This will not only decrease resemblance to in-situ structure, but also resemble a partially 

remoulded sample, which is known to be of higher disturbance. A great benefit of the DLDS is that due 

to its 40 cm diameter, which is six times larger than Ackerman tube diameter, more specimens can be 

prepared from a single depth level from one boring to account for lateral variability of the soil and test 

results. This is valid as long as standard laboratory sample dimensions are ensured. Another source of 

error is the influence of observation bias as experienced with t100 plots and the Casagrande method to 

find pre-consolidation pressure. 

 

From the available literature on the use of radiography as a sample quality assessment method, 

qualitative analysis has been mostly conducted such as detailed by Ladd and DeGroot (2003), in order 

to identify disturbance features such as gas exsolution, wall shearing and the heterogeneity of void 

spaces near the ends of the tube. Due to these features being distinguishable at a macro level, a medical-

CT scanner is sufficient for this qualitative method. While medical-CT scanners are an effective non-

destructive method to identify the aforementioned disturbance features, the resolution is insufficient to 

provide insight into the degree of densification close to the sampler wall. In order to gain an insight into 

disturbance levels at a microscopic scale, the corresponding micro-CT scanner was used. However, 

quantitative analysis of the density changes with radial dependency of oedometer specimen analysis 

has not been done before, as the study by Ngan-Tillard et al (2016) focussed on the 1D compression 



       

47 
 

effects on archaeological remains such as seeds and mussels situated in peats and clays. While the study 

by Ngan-Tillard et al (2016) with a micro-CT scan of a peat oedometer specimen demonstrated that 

fibre compaction occurred together with the surrounding soil matrix, disturbance differences between 

samplers was not the objective of this study. With the micro-CT scans of peat from the SDT database, 

it was possible to demonstrate densification of specimens with increasing radial distance from the 

centre. Specimens A4pre and A4post had an increase in greyvalue intensity relative to the centre, a 

proxy measurement for density, of 10.97% and 12.28%, respectively. For DLDS specimens D4pre and 

D4post, this parameter was 1.49% and 1.82% respectively. This translates to the Ackerman specimen 

before consolidation having 7.4 times more densification in the outer ‘skin’ volume than the DLDS 

specimens. As this methodology was not encountered in the literature study, it must be further optimised 

and the trend that Ackerman specimens show more densification at the perimeter must be validated 

with additional scans on new specimens. It was not possible to convert greyvalue intensity into density 

due to a lack of reference material with known density in the scans. Although the conditions for all 

specimens which were scanned with the micro-CT were identical, it is unknown if and by how much 

the temperature increased within the micro-CT scanner during scanning. Even though the specimens 

were wrapped in plastic foil while scanning, the increased temperature within the micro-CT could have 

had an effect on densification levels as the evaporation rate of moisture on the specimen surface 

increases. Furthermore, the indistinguishableness between peat and water in micro-CT scans adds 

uncertainty as the quantity of each material cannot be accurately defined. A procedure aimed at 

increasing contrast between peat and water in scans done by replacing the water in peat with heavy 

water (deuterium oxide), which has a low attenuation coefficient, was deemed inappropriate, due to the 

disturbance induced to the specimen with the process of drying and rehydrating. Despite using the 

highest resolution settings on the micro-CT scanner, not all peat grain diameters from the sieve analysis 

(shown in of Figure 44 Appendix C) were larger than the highest resolution of 23 μm. In addition, due 

to the high angularity of peat grains, these grains have relative ease of interlocking with one another. 

This means that these grains might be accounted for as larger than they actually are during micro-CT 

scans and sieve tests. The experimental method of using micro-CT scans to quantify disturbance is a 

resource- and time-intensive method which is often not available for geotechnical sampling companies 

to conduct as part of sample quality designation procedures.  

 

The modified Vv,b/VSCPTU disturbance method has shown that the Ackerman sample has a slightly higher 

Vs of 55.2 m/s compared to the 48.9 m/s of the DLDS, which means a 12.9% increased Vs. While these 

samples had a depth difference of 50 cm, both the SCPTU and MASW show fairly uniform Vs in the 

zone between the two sample depths, therefore negating any strong subsurface Vs heterogeneity effects. 

At the depth of interest, the confidence level of the MASW is ~100%, whereby the confidence is defined 

as the appropriateness of the modelled dispersion curve to the Vs change at a point in the cross-section. 

In addition, the relative standard error (RSE) of the respective bender element test differs due to the 

number of recorded tests, the Ackerman specimen had a 0.23% RSE and the DLDS had a 1.8% RSE. 

Therefore, the combination of these facts suggest that the difference in shear wave velocities between 

the samples is not due to soil heterogeneity, but rather due to densification of soil by the Ackerman 

sampling tube, leading to a higher degree of sample disturbance caused by the Ackerman sampler, 

compared to the DLDS.  

 

The DLDS IL oedometer results from the Deltares database stem from shallow samples, the in-situ σv 

for these samples was 6 kPa or less, while the DLDS samples D3 and D4 from the SDT database had 

an in-situ σv’ of 41.87 kPa. This highly contrasting in-situ σv may be the reason that ∆e/e0 was much 

more elevated in D3 and D4, at 35.4% and 39.4% respectively. The e0 for D3 and D4 was comparable 

to other samples in the SDT dataset, while the ∆e was an order of magnitude higher to the expected 
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value range. Other possible explanations may be that the yield stress is less than 10 kPa or that the low 

yield stress might have been breached due to swelling during transportation. Similarly to the findings 

of Boylan (2008) on Sherbrooke samples which showed very high w and water migration, the DLDS 

samples also show signs of water migration in samples, which causes an unequal distribution of w 

throughout the sample. The ∆e/e0 was plotted against in-situ σv for data from STOWA and Deltares, 

which showed that it becomes increasingly difficult to obtain organic clay or peat samples with a ∆e/e0 

of less than 7% as in-situ σv increases. When observing only the STOWA data for samples with an ∆e/e0 

under 7%, a threshold value of 155 kPa in-situ σv was established. While the trend of increasing ∆e/e0 

with increasing in-situ σv is reasonable because of the large changes in confining pressure of samples 

from deeper soil layers, it is important to keep in mind that the ∆e/e0 was developed for marine clay 

samples with a plasticity index between 6% and 43%, a w between 20% and 67%, an OCR from one to 

four, and a depth up to 25 m below ground level. All DLDS samples from the Deltares database showed 

a ∆e/e0 of less than 4%. However, when separating the parameters within the ∆e/e0, it was apparent that 

the high e0 values for the DLDS peat samples were lowering the aforementioned DLDS ∆e/e0 values 

below 4%. Meanwhile, the ∆e component of the DLDS samples remained in the same range and 

variability as the peat and organic clay samples of the Ackerman sampler. Evidently, more DLDS IL 

oedometer results would be needed at the higher in-situ σv comparable to those of the Ackerman 

samples, however this is challenging due to the DLDS design to operate at shallow depths on peats 

which generally have a low volumetric weight. The RR, which may be used to measure disturbance, 

shows dependency on the specific density of organic samples with a weak negative correlation. This 

difference was expected due to the higher percentage of mineral content in organic clays compared to 

peats. The peats sampled by the DLDS have a lower specific density when compared to those gathered 

by STOWA with the Ackerman sampler. This is consistent with the higher w found in the DLDS 

sampled peats as well.   
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7 Conclusions 
 

The main goal of this investigation was to explore how different sampling methods affect the derived 

soil properties and the consequent geotechnical design parameters in peats and organic clays. This was 

enabled by gathering existing data on tests from soils sampled by the Ackerman and DLDS samplers, 

in addition to the execution of conventional and non-conventional tests for sample disturbance 

quantification methods in the SDT database, i.e. difference in shear wave velocities, radiography and 

select parameters from IL oedometer testing.  

 

Sub-question 1: 

How does the DLDS affect consolidation parameters derived from (IL oedometer) laboratory tests in 

peats, when compared to traditional sampling techniques? 

 

Differences were observed between organic clays and peats regarding the effect of sampler type on 

consolidation parameter RR. While organic clay has a clear linear trend between w and RR, peat shows 

no definitive correlation, although lower w levels were observed for the peats sampled by the Ackerman 

sampler than for the DLDS peats. This reinforces the notion that compared to the Ackerman sampler, 

the DLDS is more capable of retaining the w of samples and is therefore more representative of in-situ 

conditions.  

 

Sub-question 2: 

What is the relationship between sample disturbance and classification parameters (yield stress, 

density)? 

 

Classification parameters were found to be heavily affected by disturbance. While 37% of Ackerman 

organic clay and peat samples have an ∆e/e0 below 7%, falling within the fair to excellent sample 

categories, the difficulty of obtaining undisturbed Ackerman samples increased with rising in-situ σv 

and therefore with depth. However, the high e0 values of the DLDS samples decreased their respective 

∆e/e0, inherently making these samples appear of less disturbance by this index. Specifically for peats, 

an elevated disturbance level measured by the RR did not indicate a drastically different specific density. 

Therefore, sample disturbance has the consequence of systematically misrepresenting geotechnical 

parameters in engineering design models, and must be measured by an appropriate disturbance 

parameter for the investigated soil.   

 

Sub-question 3:  

How do the properties (density and shear wave velocity) of peat samples derived from CT scans and 

bender element testing* compare when different samplers are used? 

 

Densification observed by micro-CT scans around the perimeter of oedometer specimens were different 

between the two samplers compared. The Ackerman specimen scanned before consolidation had a 7.4 

times higher densification in the outer ‘skin’ volume than the DLDS specimen before consolidation. 

The Vs,b was 12.9% higher for the Ackerman peat sample when compared to the DLDS sample at the 

same site in Gouda, which were respectively 65.4% and 54.4% higher than the in-situ VSCPTU. Using the 

SCPTU and bender element testing method, it was concluded that the higher value of Vs,b of the 

Ackerman sampler is due to the densification near the perimeter of the sample as observed by the micro-

CT scans. 
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Main research question: 

How does sampling affect soil properties and the consequent geotechnical design parameters? 

 

Sampling affects soil properties by altering the water content, stress states, density and chemistry of the 

soil compared to in-situ conditions. The larger diameter of the DLDS ensures more water content 

retention when compared to the Ackerman sampler, which in turn influences geotechnical parameters 

such as the RR. The diameter of the DLDS also renders more of the volume from the block as 

undisturbed, unlike the Ackerman sampler which showed higher densification around the skin of 

specimens as a result due to the friction of the tube wall. The first main conclusion is that the DLDS is 

more suitable for sampling in shallow peat, compared to the Ackerman sampler. The second main 

conclusion is that the radiography and shear wave velocity results from this study have shown that 

sample disturbance with peats may be better quantified and assessed with non-destructive methods. 

Yet, the number of samples these methods were conducted on are insufficient to firmly advise that non-

destructive testing for sample quality assessment is necessary in the geotechnical sampling industry.   
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8 Recommendations 
 

For future studies related to the topic of this thesis, it is advised to use CRS oedometer apparatus rather 

than the standard IL oedometer, due to the ability of the CRS oedometer to conduct strain controlled 

compression, which is greatly preferred due to the continuously changing strain in 1D compression 

tests. In addition, if the method detailed in this study, of CT scanning a consolidated specimen is used, 

it is proposed to develop a consolidation cell which maintains the load after the final loading stage on 

the specimen, enabling the scan of the specimen maintained at the desired σv’. This device must be of 

low density material, i.e. plastic, in order not to cause the beam hardening effect observed when 

scanning metals such as steel. It would be of interest to use the futural new micro-CT scanner in the 

Civil Engineering and Geosciences department of TU Delft, whereby sufficient space will be available 

within the scanner to accommodate a CRS (or IL) oedometer rig within it. In this way, the sample can 

be loaded during scanning to not only capture the orientation changes of peat fibres, but also regional 

densification throughout the 1D consolidation process. However, this method will need rapid scanning 

settings, which will entail a decreased resolution due to the continually changing configuration of grains 

in specimens. If this method can be accomplished, it is encouraged to develop an experimental setup 

whereby an Ackerman sampling tube is penetrating a DLDS sampled block while making a CT scan, 

either with the medical-CT or micro-CT scanner, in order to observe the edge effect of the tube on the 

soil in different phases. Appropriate steps such as sufficient lateral support of the DLDS block must be 

taken if this method is pursued. The aforementioned setup will also enable the comparison in density 

changes of the exact same soil portion before and after using the Ackerman tube to sample the DLDS 

block.  

 

As argued in section 3.3, the Ackerman sampler falls short by 3 mm of the required minimum inner 

diameter of samples needed in order to be classified as appropriate for sampling organic clays and peats 

for category A samples. For the sampling industry in the Netherlands, it is therefore advised to increase 

the inner diameter of Ackerman tubes to between 70 mm and 120 mm and use a length of 600 mm such 

that category A samples are achieved. 

 

It is highly recommended to gather more IL oedometer DLDS data, as deployment of the sampler 

continues. This will alter the reliability of the results and reasonings discussed in this thesis. In addition, 

it is encouraged to repeat the SCPTU test with the APvdBerg system, as the failure detailed in section 

4.4 resulted in no shear wave velocity readings to compare to the Geomill system at the desired depth. 

This will enable a more comprehensive analysis of the difference of using these systems for non-

destructive disturbance testing quantification. Moreover, further shear wave velocity comparison tests 

should be made using the methods described in sections 4.2 and 5.1.3 to further demonstrate the 

applicability of this method in organic soils. Results from the micro-CT image analysis method should 

be reproduced in order to confirm the trend of higher densification observed with increasing radial 

distance from the centre for Ackerman samples. Specimen temperature rose till 26.5°C during 

pycnometer testing, while micro-CT scanning increased specimen’s temperature by an unknown 

quantity, which may have degraded the organic matter present in the specimens. It is important to 

determine whether this has an effect on the structure of peats. Therefore, it is advised for geotechnical 

sampling companies to use the DLDS to sample shallow peats and to treat disturbance quantification 

of peat samples differently than before.  
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Challenges occur when comparing different samplers used at different site locations because variables 

such as the depth of the ground water table play a fundamental role in comparing disturbance of 

samples. In this investigation, no sampling site had both the use of the Ackerman sampler and DLDS 

for a side-by-side comparison. As this set-up is highly valuable for limiting variables, it is recommended 

to increase the number of occasions this opportunity occurs. Finally, while higher water contents in peat 

samples are representative of in-situ conditions, the study by Boylan et al. (2008) and the results from 

this thesis have shown that high water content lead to water migration within the sample in its respective 

container, which will lead to different specimen properties depending on the location the specimen is 

extracted from within the sample. This may be mitigated by a suction device within the sample tube, 

which can keep the water content distribution constant throughout the sample.   



       

53 
 

9 References 
 

Amundsen et al. (2015). “Comparison of two sample quality assessment methods applied to 

oedometer test results”. IOS Press, 923-930, DOI: 10.3233/978-1-61499-601-9-923. 

Andresen, A. and Kolstad, P. (1979). “The NGI 54-mm samplers for undisturbed sampling of clays 

and representative sampling of coarser materials”. Proceedings of the International Symposium of Soil 

Sampling, State of the Art on Current Practice of Soil Sampling, 13-23. 

ASTM International. (2005). “Standard Guide for Selection of Soil and Rock Sampling Devices Used 

With Drill Rigs for Environmental Investigations”. ASTM D6169 – 98, West Conshohocken, 

Pennsylvania, United States. 

ASTM International. (2018). “Standard Practices for Obtaining Intact Block (Cubical and Cylindrical) 

Samples of Soils”. ASTM D7015/D7015M, West Conshohocken, Pennsylvania, United States. 

Baligh et al. (1987). “Disturbances due to ideal tube sampling”. Journal of Geotechnical Engineering 

Volume 113 Issue 7. 

Boylan, N. (2008). “The Shear Strength of Peat”. University College Dublin. 

Clayton et al.  (1998). “Effects of sampler design on tube sampling disturbance - numerical and 

analytical investigations”. Géotechnique 48, No. 6, 847-867. 

Chung, S. and Kweon, H.J. (2013). Oil-Operated Fixed-Piston Sampler and Its Applicability. 

[diagram]. https://www.researchgate.net/publication/264862318_Oil-Operated_Fixed-

Piston_Sampler_and_Its_Applicability 

CUR (2005). “Uitvoering en Interpretatie samendrukkingsproef”. Aanbeveling 101. CUR. 

DeGroot et al (2005). “Sample disturbance – soft clays”. Studia Geotechnica et Mechanica. Vol. 27 

Issue 3/4, p91-105. 15p. 

Deltares (2020). “Extra grote veenmonsters om bodemdaling te voorspellen” [Photograph]. 

https://www.h2owaternetwerk.nl/h2o-actueel/extra-grote-veenmonsters-om-bodemdaling-te-

voorspellen 

 

Dong et al. (2016). “Dependencies of Shear Wave Velocity and Shear Modulus of Soil on 

Saturation”. Colorado School of Mines.  

 

Donohue, S. and Long, M., (2010). “Assessment of sample quality in soft clay using shear wave 

velocity and suction measurements”. Géotechnique. 60(11), 883-889. 

 

Ferreira et al. (2011). “Shear wave velocities for sample quality assessment on a residual soil”. 

Japanese Geotechnical Society. Vol. 51, No. 4, 683-692.  

 

Head, K. H. and Epps, R. J. (2011). “Manual of Soil Laboratory Testing”. Whittles Publishing. Vol. 2 

Ch. 14. 

 



       

54 
 

Helenelund et al. (1972). “Influence of sampling disturbance on the engineering properties of peat 

samplings”. Proceedings of the international peat congress. 229-240. 

 

Karlsrud K., Hernandez-Martinez, F.G. (2014). “Strength and deformation properties of Norwegian 

clays from laboratory tests on high-quality block samples”. Canadian Geotechnical Journal. 50(12): 

1273-1293. https://doi.org/10.1139/cgj-2013-0298 

Konrad, J.-M., Gilbert, F., Pouliot, N., and Saint-Laurent, S.1995a. “Large diameter sampling of 

sands”. CANLEX Technical Report, Phase II, Activity 4C, Université Laval, Sainte-Foy. 

La Rochelle, P., Sarrailh, J., Tavenas, F., Roy, M., and Leroueil, S.1981. “Causes of sampling 

disturbance and design of a new sampler for sensitive soils”. Canadian Geotechnical Journal, 18: 52–

66.  

Lacasse, S. and Berre, T. (1988). “State-of-the-Art: Triaxial testing methods for soils”. ASTM 

International STP29081S, 264-289. DOI: 10.1520/STP29081S. 

Ladd  C.C.,  DeGroot  D.J. (2003). “Recommended  practice  for  soft  ground  site  charaterization:  

Arthur  Casagrande  Lecture”. 12th Panamerican Conference on Soil Mechanics and Geotechnical 

Engineering.  

Ladd, C.C., Azzouz, A.S., Martin, R.T., Day, R.W., and Malek, A.M., (1980). “Evaluation of the 

compositional and engineering properties of offshore Venezuelan soils”. M. Dept. of Civil Engr. 

Ladd  C.C.,  DeGroot  D.J. (2003). “Recommended  practice  for  soft  ground  site  charaterization:  

Arthur  Casagrande  Lecture”. 12th Panamerican Conference on Soil Mechanics and Geotechnical 

Engineering. 

Landon et al. (2007). “Nondestructive Sample Quality Assessment of a Soft Clay Using Shear Wave 

Velocity”. Journal of Geotechnical and Geoenvironmental Engineering 133(4). 

Luijendijk, S. (2016). “Deltares Large Diameter Sampler resultaten”. Deltares. 

Lunne et al. (1997). “Sample disturbance effects in low plastic Norwegian clay”. Canadian 

Geotechnical Journal, 43, 726-750.  

Mayne et al. (2009). “State-of-the-art paper (SOA-1): geomaterial behavior and testing”. Conference: 

17th International Conference on Soil Mechanics and Geotechnical Engineering Volume 4.  

Ministry of Infrastructure and Water Management (2016). “Samendrukkingsproeven”. 

Schematiseringshandleiding macrostabiliteit. The Hague, Netherlands. 

Ngan-Tillard et al. (2016). “Tools for Predicting Damage to Archaeological Sites Caused by One-

Dimensional Loading” Conservation and Management of Archaeological Sites, 18:1-3, 70-85, DOI: 

10.1080/13505033.2016.1181934 

 

NEN (1989). “Geotechnics - Classification of unconsolidated soil samples”. (NEN 5104:1989 nl). 

NEN.  

 

NNI (2018). “Geotechnical investigation and testing - Sampling methods and groundwater 

measurements - Part 1: Technical principles for the sampling of soil, rock and groundwater.” (NEN-

EN-ISO 22475-1:2021). ISO. Geneva, Switzerland.  

 



       

55 
 

NNI (2021). “Geotechnical investigation and testing - Sampling methods and groundwater 

measurements - Part 1: Technical principles for the sampling of soil, rock and groundwater.” (NEN-

EN-ISO 22475-1:2021). ISO. Geneva, Switzerland.  

 

Nordmeyer (n.d.). “HBS”. Hollow stem auger system. [image] 

http://www.nordmeyer.nl/membersonly/HBS%20english.pdf 

 

Pirouzi, A. and DeGroot, D. (2019). “Evaluation of recompression index for structured clays from 

laboratory constant rate of strain consolidation tests”. GeoEngineers, Inc., San Diego, CA, USA. 

Tanaka, H. (1996). “Characteristics of Drammen clay measured by Port and Harbour Research 

Institute (PHRI), Japan”. Port and Harbour Research Institute. 

Tanaka, H., (2000). “Sample quality of cohesive soils : Lessons from three sites, Ariake, Bothkennar 

and Drammen”. Soils and foundations. 20(4), 57-74. 

TAW. (2001). “Bijlage 3, Boringen”. Technisch Rapport Waterkerende Grondconstructies. 263-265. 

Van Essen, H. (2021). “Wandwrijving samendrukkingsproef”. Deltares. 

Wride et al. (2000). “Ground sampling program at the CANLEX testsites”. Canadian Geotechnical 

Journal, 37, 530-542.  

Zwanenburg, C. (2017a). “Development of a Large Diameter Sampler”. Proceedings of the 19th 

International Conference on Soil Mechanics and Geotechnical Engineering. Seoul, South Korea. 

Zwanenburg, C. (2017b). “SBRCURnet kwaliteit van grondonderzoek (monsterverstoring veen)”. 

[presentation]. Deltares. 

  



       

56 
 

Appendices  
 

A Pycnometer results 
 

The results of the pycnometer test, which was used to establish a G value for every sample, are shown 

in Table 13.  

 

Table 13: Pycnometer test results 

Specimen name  Input mass (g) Average volume 

(cm3) 

Average density 

(g/cm3) 

Standard deviation 

of density (g/cm3) 

D1/D2 16.3400 10.2015 1.6017 0.0014 

A1/A2 55.3800 23.7801 2.3288 0.0068 

A3/A4 17.6700 10.1519 1.7406 0.0043 

D3/D4 16.7100 13.0560 1.2799 0.0021 

 

 

B  SCPTU shear wave velocities 
 

The SCPTU test, which measures the in-situ shear wave velocity at different depths, is shown in Table 

14 by the two different systems used. 

 

Table 14: SCPTU shear wave velocities by measurement system. 

Interval (m) Geomill system shear wave 

velocity (m/s) 

APvdBerg system shear wave 

velocity (m/s) 

Difference between 

Geomill and APvdBerg 

systems (%) 

1.0 – 1.5 87 84 3.51 

1.5 – 2.0 71 89 22.5 

2.0 – 2.5 83 51 47.8 

2.5 – 3.0  30 47 44.2 

3.0 – 3.5  84 29 97.3 

3.5 – 4.0  29 25 14.8 

4.0 – 4.5 19 29 41.7 

4.5 – 5.0 27 -   

5.0 – 5.5 28 -  

5.5 – 6.0 28 -  

6.0 – 6.5 48 -  

6.5 – 7.0 51 -  

7.0 – 7.5 46 -  

7.5 – 8.0 42 -  

8.0 – 8.5 40 -  

8.5 – 9.0 40 -  

9.0 – 9.5 63 -  

9.5 – 10.0 127 -  

10.0 – 10.5 121 -  

10.5 – 11.0 153 -  
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C Wet sieve analysis results 
 

The intention of the wet sieve analysis on peat sample VN80625-1-1 was to gain an insight into the 

grain size distribution and the appropriateness of the applied maximum micro-CT resolution of 23 μm.  

 

 
Figure 44. Wet sieve analysis result for sample VN80625-1-1. 

 

 

D Image analysis script  
 

Table 15 details the commands used to analyse the specimens scanned by the micro-CT scanner. The 

known components of the samples are a majority of water filled pores, peat, air filled pores and sand 

grains. A computer with 32GB RAM was used due to the large image files and processing power 

demand. The following installed plugins are required in ImageJ before starting analysis: Concentric 

circles, Z Project Ignore NaNs.  

 

Table 15. Image analysis methodology. 

Action Meaning Comments 

File -> import -> image sequence -> 

“A4post” 

Get a new file for analysis  

Image -> adjust -> threshold  

Use 6635-65535 thresholding range 

(Off) Calculate threshold for each 

image, then apply 

This range is for all the 

solids and liquid in the 

specimen 

Will create a binary image 

stack whereby the volume 

of interest will be ones and 

the background will be 

zeros 

Process -> binary -> fill holes Fills the pores in the 

specimen with 1s 

Will fill the air pores 

within the sample 
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Process -> binary -> options  

Iterations: 20 

Black background: v 

Do: Open 

Now we have the volume 

of interest of the specimen 

Makes an erosion 

operation, followed by 

dilation in order to remove 

the outer ring. 

File -> Save -> name: 

“A4postVolumeofInterest” 

  

File -> import -> image sequence -> 

“A4post” 

  

Image -> adjust -> threshold  

Use 12606-65535 thresholding range 

(Off) Calculate threshold for each 

image, then apply 

This is the greyvalue 

intensity range for the high 

density silica in the 

specimen 

Will create a binary image 

stack whereby the silica 

grains will be ones and the 

rest will be zeros. 

File -> Save -> name: “A4postSilica”   

File -> import -> image sequence -> 

“A4post” 

  

Image -> adjust -> threshold  

Use 1-6635 thresholding range 

(Off) Calculate threshold for each 

image, then apply 

The thresholding values 

range for the macro pores 

in the specimen 

Will create a binary image 

stack whereby the pores in 

the peat will be ones and 

the rest will be zeros. 

File -> Save -> name: 

“A4postMacropores” 

  

File -> import -> image sequence -> 

“A4post” 

  

Process -> image calculator 

Image1: “A4postVolumeofInterest” 

Operation: min 

Image2: “A4post” 

Overlaying greyvalues onto 

the volume of interest 

 

File -> Save -> name: 

“A4postVolumeInterest+greyvalues” 

  

Process -> image calculator 

Image1: 

“A4postVolumeInterest+greyvalues” 

Operation: subtract 

Image2: “A4postSilica” 

Removing silica material 

from image stack 

 

File -> Save -> name: 

“A4postMinusSilica” 

  

Process -> image calculator 

Image1: “A4postMinusSilica” 

Operation: subtract 

Image2: “A4postMacropores” 

Removing macro pores 

from image stack 

The resulting image stack 

will be only the greyvalue 

intensity for the organic 

matter and water in peat. 

File -> Save -> name: “A4postpeat” This image is now in 8-bit 

due to the aforementioned 

operations, which involved 

several 8-bit binary image 

stack, downgrading the 16-

bit  

For A4post -> 8-bit 

greyvalues: silica ~200, 

air: ~25, peat: ~37 
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Image -> Type -> 32-bit 

 

Converting to 32-bit which 

is needed for the later step 

of changing the zeros to 

NaNs. 

This will not scale the 

greyvalues from 8-bit. 

Image -> Adjust -> Threshold 

Use 1-1e30 

NO apply 

Selecting the peat and not 

the background, in order to 

set zeros to NaNs. 

 

Process -> Math -> NaN Background The zeros will be set to 

NaNs, which is needed as 

only the organic matter and 

water in peat must be 

analysed when making the 

Z projection. 

 

Reset threshold   

Plugins -> Z Project Ignore NaNs  An average intensity along 

the Z axis is calculated and 

projected onto one image 

file.  

This operation does not 

have a status bar and 

processing can take some 

time.  

File -> Save -> name: 

“A4postProjection” 

  

Plugins -> Concentric Circles 

Number of circles: 200 

Inner radius: 10 

Adjust coordinates to the centre of the 

specimen accordingly 

Measure: v 

Ok 

An average intensity is 

calculated along the 

perimeter of each circle, for 

each radius size, displayed 

in the pop up results 

window. 

 

Copy data from popup window to excel  Graph distance to centre (x 

axis) vs greyvalue intensity 

(y axis). 

 

Using the image stack named 

“A4postpeat” again for the following 

(similar) steps to calculate the standard 

deviation at each point: 

  

Image -> Adjust -> Threshold 

Use 1-1e30 

NO apply 

Selecting the peat and not 

the background, in order to 

set zeros to NaNs. 

 

Process -> Math -> NaN Background The zeros will be set to 

NaNs, which is needed as 

only the organic matter and 

water in peat must be 

analysed when making the 

Z projection. 

 

Reset threshold   

Image -> stacks -> Z Project 

Projection type: standard deviation 

The resulting single image 

will have standard 

deviation values calculated 
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along the z-axis of the 

specimen 

File -> Save -> name: 

“A4postSDTProjection” 

  

Plugins -> Concentric Circles 

Number of circles: 200 

Inner radius: 10 

Adjust coordinates to the centre of the 

specimen accordingly 

Measure: v 

Ok 

An average standard 

deviation is calculated 

along the perimeter of each 

circle, for each radius size, 

displayed in the pop up 

results window. 

 

Copy data from popup window to excel  Add to data after 

converting to relative 

standard error (RSE) as 

uncertainty measurement 

 

The same steps above are used to 

calculate the greyvalue intensity for the 

other three scans, substituting with use 

of the appropriate file naming: A4pre, 

D4post and D4pre. The threshold 

ranges for these specimens are listed in 

Table 16 . 

 

  

 

 

Table 16: Threshold ranges and iterations for different phases per specimen. 

Specimen name Volume of interest threshold Iterations Silica threshold Pores threshold 

A4post 6635-65535 20 12606-65535 1-6635 

A4pre 8493-65535 5 15714-65535 1-8493 

D4post 5480-65535 6 7499-65535 1-5480 

D4pre 6202-65535 5 9004-65535 1-6202 

 

 

Table 17: Peak greyvalue intensity values from greyvalue histograms by phase type per specimen. 

Specimen name Image bits Air peak Peat peak 

A4post 16 ~5287 ~8812 

8 24 40 

A4pre 16 ~6886 ~10820 

8 34 55 

D4post 16 ~4884 ~6321 

8 35 44 

D4pre 16 ~5381 ~7573 

8 28 40 
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E SDT IL oedometer data 
 

The full list of properties and parameters from the IL oedometer tests in the SDT database can be 

found in Table 18.  

 

Table 18: Full dataset of IL oedometer tests in SDT database (continued on next page). 
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11204108 D1 Peat 65 29.5 94.9 83.0 DLDS 14 5.6 1.4 Vlist 0.46 0.93 1.86 3.72 

11204108 D2 Peat 65 19.5 71.1 60.08 DLDS 14 5.6 1.4 Vlist 0.46 0.93 1.86 3.72 

2A 3 2 A1 
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VX-

80625-1 D3 Peat 65 19.5 62.1 23.3 DLDS 9.5 41.87 5.06 Gouda 3.47 6.95 13.89 27.79 

VX-
80625-1 D4 Peat 65 29.5 93.0 35.8 DLDS 9.5 41.87 5.06 Gouda 3.47 6.95 13.89 27.79 
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D1 7.43 3.72 7.43 18.58 - 1.6 2.75 4.8 0.412 8.55 11.2 5.6 2 305 - 0.056 

D2 7.43 3.72 7.43 18.58 - 1.6 2.75 4.8 0.433 8.99 11.2 5.6 2 305 - 0.103 

A1 18.51 9.25 18.51 46.27 74.02 2.33 6.34 2.7 0.221 8.26 28 13.9 2 173 0.020 0.018 

A2 18.51 9.25 18.51 46.27 74.02 2.33 6.34 2.7 0.195 7.29 32 13.9 2.3 173 0.016 0.014 

A3 12.88 6.44 12.88 25.75 51.50 1.74 2.98 4.8 0.307 6.35 15 9.7 1.5 308 - 0.028 

A4 12.88 6.44 12.88 25.75 51.50 1.74 2.98 4.8 0.255 5.26 21 9.7 2.2 308 0.030 0.027 
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